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C H A P T E R 1
Network Deployments in Cisco ISE

• Cisco ISE network architecture, on page 1
• Cisco ISE deployment terminology, on page 2
• Node types and personas in distributed deployments, on page 3
• Cisco ISE deployment models, on page 4
• Small network deployments, on page 4
• Medium-sized network deployments, on page 6
• Large network deployments, on page 7
• Cisco ISE deployment sizing guidelines, on page 9
• Switch and Wireless LAN Controller configuration required to support Cisco ISE functions, on page 10

Cisco ISE network architecture
Cisco ISE network architecture integrates specialized nodes and deployment models to deliver comprehensive,
scalable network access control and security policy enforcement.

The core components include nodes with specific personas that work together to manage network access and
security. It supports various deployment models, including standalone and distributed setups, suited for small
to large networks. This architecture ensures scalable, secure, and efficient policy enforcement across wired,
wireless, and VPN connections.

Cisco ISE network architecture components

Cisco ISE architecture includes these components:

Table 1: Components of Cisco ISE network architecture

DescriptionCisco ISE network components

Cisco ISE servers that run one or more roles. A node can run
multiple personas.

Nodes (personas or roles)

Infrastructure that controls or provides network access, such as
switches, WLCs, VPN devices and so on.

Network resources

Users or devices trying to connect to the network, such as laptops,
phones, printers, IoTand so on.

Endpoints
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Cisco ISE nodes and personas

A Cisco ISE node can assume any or all of these personas:

Table 2: Cisco ISE nodes and personas

Use casesRolePersona

Primary or secondary admin nodesManages configuration and system settingsAdministration persona

RADIUS andTACACS+processingMakes access-control decisions and enforces policy

The policy information point (PIP) is where external information
is communicated to the Policy Service persona. For example,
external information might be a Lightweight Directory Access
Protocol (LDAP) attribute.

Policy Service persona
(PSN)

Troubleshooting, audits, reportsCollects logs and reporting dataMonitoring persona

Integrations with security toolsShares context with other systemspxGrid persona

Cisco ISE deployment terminology
This book uses these terms to discuss Cisco ISE deployment scenarios:

DefinitionTerm

A specific feature that a persona provides, such as network access,
profiling, posture, security group access, monitoring, or
troubleshooting.

Service

An individual physical or virtual Cisco ISE appliance.Node

The Cisco ISE node can assume any or all of these personas:

• Administration

• Policy Service

• Monitoring

• pxGrid

Node type

Determines the services provided by a node. The administrative
user interface menu options depend on the roles and personas that
a node assumes.

Persona

This determines whether a node is standalone, primary, or
secondary, and applies only to Administration and Monitoring
nodes.

Role
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Node types and personas in distributed deployments
Each Cisco ISE node provides different services depending on its assigned persona. In a distributed deployment,
you can have these combinations of nodes in your network:

• Primary and secondary Administration nodes for high availability

• A pair of Monitoring nodes for automatic failover

• One or more Policy Service nodes for session failover

• One or more pxGrid nodes for pxGrid services

Administration nodes
A Cisco ISE node with the Administration persona allows you to perform all administrative operations on
Cisco ISE. It handles all system-related configurations that are related to functionalities such as authentication,
authorization, auditing, and so on.

In a distributed deployment, you can have a maximum of two nodes running the Administration persona. The
Administration persona can take on of these roles—standalone, primary, or secondary.

Policy Service nodes
A Cisco ISE node with the Policy Service persona provides network access, posture, guest access, client
provisioning, and profiling services. This persona evaluates policies and makes decisions.

You can have more than one node assume this persona. Typically, distributed deployments have more than
one Policy Service node.

You can group all Policy Service nodes that reside in the same high-speed local area network (LAN) or are
behind a load balancer as a node group. If one node in a group fails, the other nodes detect the failure and
reset URL-redirected sessions.

At least one node in your distributed setup should assume the Policy Service persona.

Monitoring nodes
A Cisco ISE node with the Monitoring persona

• functions as the log collector and stores log messages from all the Administration and Policy Service
nodes.

• provides advanced monitoring and troubleshooting tools to effectively manage a network and resources.

• aggregates and correlates the data that it collects and provides meaningful reports.

You can have a maximum of two nodes with this persona, and they can take on primary or secondary roles
for high availability. In case the primary Monitoring node goes down, the secondary Monitoring node
automatically becomes the primary Monitoring node.
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At least one node in your distributed setup should assume the Monitoring persona. We recommend that you
do not have theMonitoring and Policy Service personas enabled on the same Cisco ISE node. We recommend
that the Monitoring node be dedicated solely to monitoring for optimum performance.

pxGrid nodes
You can use Cisco pxGrid to share context-sensitive information from Cisco ISE session directory with other
network systems such as ISE ecosystem partner systems and other Cisco platforms. The pxGrid framework
can also be used to exchange policy and configuration data between nodes, such as sharing tags and policy
objects between Cisco ISE and third-party vendors, and for other information exchanges. Cisco pxGrid also
allows third-party systems to invoke adaptive network control actions to quarantine users or devices in response
to a network or security event.

TrustSec information, such as tag definition, value, and description, can be passed from Cisco ISE to other
networks through the TrustSec topic. You can publish and subscribe to SXP bindings (IP-SGT mappings)
through pxGrid.

Endpoint profiles with fully qualified names (FQNs) can be passed from Cisco ISE to other networks through
an endpoint profile meta topic. Cisco pxGrid also supports bulk download of tags and endpoint profiles.

In a high-availability configuration, pxGrid servers replicate information between nodes through the PAN.
When the PAN goes down, the pxGrid server stops handling client registration and subscription. You must
manually promote the PAN to activate the pxGrid server.

Only the clients that are part of the groups included in the policy can subscribe to the service specified in that
policy.

Restriction

Cisco ISE deployment models
Cisco ISE deployment models illustrate how Cisco ISE nodes and personas are arranged to meet specific size,
performance, and availability requirements.

Standalone deployment

A deployment that has a single Cisco ISE node is called a standalone deployment. This node runs the
Administration, Policy Service, and Monitoring personas.

Distributed deployment

A deployment that has more than one Cisco ISE node is called a distributed deployment. To support failover
and improve performance, you can deploy multiple Cisco ISE nodes in a distributed way. In a Cisco ISE
distributed deployment, administration and monitoring activities are centralized, and processing is distributed
across Policy Service nodes. Depending on your performance needs, you can scale your deployment.

Small network deployments
The smallest Cisco ISE deployment consists of two Cisco ISE nodes with one Cisco ISE node functioning as
the primary node.
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The primary node manages all configuration, authentication, and policy tasks for your network. The secondary
node acts as a backup. If connectivity is lost between the primary node and network appliances, network
resources, or RADIUS, the secondary node supports the primary node and keeps the network running.

Centralized authentication, authorization, and accounting (AAA) operations between clients and the primary
node are performed using the RADIUS protocol. Cisco ISE synchronizes all content from the primary node
to the secondary node. In a small network deployment, you can configure both nodes on all RADIUS clients
by using this model or a similar approach.

Figure 1: Small network deployment of Cisco ISE nodes

If you want to add more devices, network resources, users, or AAA clients, switch from the small deployment
model to a split or distributed deployment model.

Split deployments
A split deployment in Cisco ISE separates key personas across different nodes, for example, running the
Administration and Monitoring personas on one node and the Policy Service persona on separate nodes. This
deployment model improves performance and scalability by isolating policy processing from management
and reporting functions.

Split deployment provides better load distribution and ensures that the secondary node remains functional
during normal network operations. This design also supports deployment expansion.

In split deployments, the AAA load is split between the primary and secondary nodes to optimize the AAA
workflow.
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Each node must be able to handle the full workload if there are any problems with AAA connectivity. During
normal network operations, neither the primary node nor the secondary node handles all AAA requests,
because the workload is distributed between the two nodes.

In split deployments, each node can perform its own specific operations, such as network admission or device
administration, and still perform all the AAA functions if a failure occurs. If two nodes process authentication
requests and collect accounting data from AAA clients, configure one node to act as a log collector.

Figure 2: Split network deployment in Cisco ISE

Medium-sized network deployments
As small networks grow, you can manage network growth by adding nodes to create a medium-sized network.
In medium-sized network deployments, you can dedicate the new nodes for all AAA functions and use the
original nodes for configuration and logging functions.

If the amount of log traffic increases in a network, you can dedicate one or two secondary nodes for log
collection.

In a medium-sized network deployment, you cannot enable the Policy Service persona on a node that runs
the Administration persona or the Monitoring persona. You need dedicated policy service nodes.

Restriction
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Figure 3: Medium-sized network deployment in Cisco ISE

Large network deployments
Large network deployments in Cisco ISE use distributed nodes for optimal load sharing, high authentication
volume support, operational resilience, and scalable policy enforcement.

In a Cisco ISE distributed deployment, administration and monitoring activities are centralized, and processing
is distributed across the Policy Service nodes. Depending on your performance needs, you can scale your
deployment.

Centralized log management
We recommend that you use centralized logging for large Cisco ISE networks. To use centralized logging,
you must first set up a dedicated logging server that acts as a Monitoring node to handle the potentially high
syslog traffic that a large, busy network can generate.

You can use an RFC 3164-compliant syslog appliance to collect the syslog messages generated for outbound
log traffic.

You can also consider having the appliances send logs to both a Monitoring node and a generic syslog server.
A generic syslog server provides redundant backup if the Monitoring node goes down.

Load balancers for centralized networks
You can load balancers for large, centralized networks to optimize the routing of AAA requests to the available
servers.
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Having only a single load balancer creates a single point of failure in the system. To avoid this potential issue,
deploy two load balancers to ensure redundancy and failover. This configuration requires you to set up two
AAA server entries in each AAA client.

Figure 4: A large network deployment using a load balancer

Dispersed network deployments
Dispersed Cisco ISE network deployments are most useful for organizations that have a main campus with
regional, national, or satellite locations elsewhere. The main campus is where the primary network resides.
It is connected to additional LANs, ranges in size from small to large, and supports appliances and users in
different geographical regions and locations.

Large remote sites can have their own AAA infrastructure for optimal AAA performance. Use a centralized
management model to maintain a consistent, synchronized AAA policy. A centralized configuration model
uses a primary Cisco ISE node with secondary Cisco ISE nodes.
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Figure 5: Dispersed deployment in Cisco ISE

Considerations for planning a network with several remote sites
Consider these factors when planning a network with several remote sites:

• Ensure that each remote site has a synchronized instance of the external database available for Cisco ISE
access to optimize AAA performance.

• Locate Cisco ISE nodes as close as possible to AAA clients to reduce latency and prevent access loss
during WAN failures.

• Use a terminal at each site for direct, secure console access. This is needed for certain functions, such
as backup.

• If small, remote sites are in close proximity and have reliable WAN connectivity to other sites, consider
using a Cisco ISE node as a backup for the local site to provide redundancy.

• Configure DNS correctly on all Cisco ISE nodes to ensure access to external databases.

Cisco ISE deployment sizing guidelines
For information about the deployment sizing guidelines and the scale limits for different types of Cisco ISE
deployment, see Performance and Scalability Guide for Cisco Identity Services Engine.
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Switch and Wireless LAN Controller configuration required to
support Cisco ISE functions

To enable Cisco ISE to interoperate with network switches and to ensure successful function of Cisco ISE
across the network segment, configure your network switches with required settings such as Network Time
Protocol (NTP), RADIUS, AAA, IEEE 802.1X, MAC Authentication Bypass (MAB), and so on.

ISE Community Resource

For information about setting up Cisco ISE with WLC, see Cisco ISE with WLC Setup Video.
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C H A P T E R 2
Cisco Secured Network Server Series
Appliances and Virtual Machine Requirements

• Cisco ISE hardware and virtual appliance requirements, on page 11
• VMware cloud solutions for Cisco ISE, on page 29
• Virtual machine size recommendations, on page 29
• Disk space requirements for VMs in a Cisco ISE deployment, on page 30
• Disk space guidelines for Cisco ISE, on page 31
• CPU requirements for hypervisors, on page 33

Cisco ISE hardware and virtual appliance requirements
Cisco ISE can be installed on Cisco Secure Network Server (SNS) hardware or virtual appliances. The virtual
machine should have the same system resources as the Cisco SNS hardware appliances to achieve similar
performance and scalability as the Cisco ISE hardware appliance. This section lists the hardware, software,
and virtual machine requirements for installing Cisco ISE.

Cisco ISE pxGrid Direct Service and Cisco ISE pxGrid Direct Pusher require a CPU that supports the x86-64-v2
architecture or higher. If the CPU does not support x86-64-v2 or if a hypervisor masks the required CPU
features for a virtual machine, Cisco ISE pxGrid Direct Service and Cisco ISE pxGrid Direct Pusher do not
start.

Harden your virtual environment and ensure that all security updates are current. Cisco is not liable for any
security issues found in hypervisors.

For all VMs, you must use the application stop command before using the halt command or powering off
the VM to prevent database corruption issues.

Note

Cisco ISE does not support VM snapshots to back up data on any virtual environment. Enabling the Snapshot
feature on the VM might corrupt the configuration. If this happens, you may need to reimage the VM.

Caution
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Cisco SNS hardware appliances
For Cisco SNS 3600 series appliances, see Cisco SNS-3600 Series Appliance Hardware Installation Guide.

For Cisco SNS 3700 series appliances, see Cisco SNS-3700 Series Appliance Hardware Installation Guide.

For Cisco SNS 3800 series appliances, see Cisco SNS-3800 Series Appliance Hardware Installation Guide.

For information about the supported hardware platforms for your version of Cisco ISE, see the Release Notes
for Cisco Identity Services Engine.

Support for Cisco SNS 3800 series appliance
The Cisco SNS 3800 series appliances are based on the Cisco Unified Computing System (Cisco UCS) C225
M8 Rack Server and are configured specifically to support Cisco ISE. Cisco SNS 3800 series appliances are
designed to deliver high performance and efficiency for a wide range of workloads.

The Cisco SNS 3800 series appliances are available in these models:

• Cisco SNS 3815 (SNS-3815-K9)

• Cisco SNS 3855 (SNS-3855-K9)

• Cisco SNS 3895 (SNS-3895-K9)

Cisco SNS 3815 appliance is ideal for small deployments. Cisco SNS 3855 and Cisco SNS 3895 appliances
have several redundant components such as hard disks and power supplies and are suitable for larger
deployments that require highly reliable system configurations. Cisco SNS 3895 is recommended for PAN
and MnT personas.

• You must use only these OVA, ISO, and upgrade bundle files for Cisco SNS 3800 appliances:

• Cisco-vISE-300-3.4.0.608b.ova

• Cisco-vISE-600-3.4.0.608b.ova

• Cisco-vISE-1200-3.4.0.608b.ova

• Cisco-vISE-2400-3.4.0.608b.ova

• ise-3.4.0.608b.SPA.x86_64.iso

• ise-upgradebundle-3.1.x-3.3.x-to-3.4.0.608b.SPA.x86_64.tar.gz

• ise-urtbundle-3.4.0.608b-1.0.0.SPA.x86_64.tar.gz

• Cisco SNS 3800 appliances are supported from Cisco ISE release 3.4 patch 4 onwards.

• Cisco SNS 3855 appliance can be configured with one hard disk or four hard disks. It is recommended
to enable only the PSN or pxGrid persona if your Cisco SNS 3855 appliance is configured with only one
hard disk.

Note

This table describes the hardware specifications of Cisco SNS 3800 series appliances.
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Table 3: Cisco SNS 3800 series appliance hardware specifications

RAIDTotal hard disk
capacity

Number of hard
disks

CPU coresRAMCisco SNS 3800
series appliance

NA960 GBNVME-116 cores, 32
threads

64 GBCisco
SNS-3815-K9

RAID-0960 GBSED-116 cores, 32
threads

64 GB

RAID-01.6 TBSED-FIPS-116 cores, 32
threads

64 GB

NA960 GBNVME-124 cores, 48
threads

128 GBCisco
SNS-3855-K9

RAID-101.9 TBNVME-424 cores, 48
threads

128 GB

RAID-0960 GBSED-124 cores, 48
threads

128 GB

RAID-101.9 TBSED-424 cores, 48
threads

128 GB

RAID-01.6 TBSED-FIPS-124 cores, 48
threads

128 GB

RAID-103.2 TBSED-FIPS-424 cores, 48
threads

128 GB

RAID-103.8 TBNVME-824 cores, 48
threads

256 GBCisco
SNS-3895-K9

RAID-103.8 TBSED-824 cores, 48
threads

256 GB

RAID-106.4 TBSED-FIPS-824 cores, 48
threads

256 GB

For more information, see the Cisco SNS 3800 Series Appliance Hardware Installation Guide.

VMware virtual machine requirements
You can use the VMware migration feature to migrate VM instances (running any persona) between hosts.
Cisco ISE supports both hot and cold migration.

• Hot migration is also called live migration or vMotion. You do not need to shut down or power off Cisco
ISE during hot migration. You can migrate the Cisco ISE VMwithout any interruption in its availability.

• Cisco ISE must be shutdown and powered off for cold migration. Cisco ISE does not allow to stop or
pause the database operations during cold migration. Hence, ensure that Cisco ISE is not running and
active during the cold migration.
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The 300 GB OVA templates are sufficient for Cisco ISE nodes that serve as dedicated Policy Service or
pxGrid nodes.

The 600 GB and 1.2 TB OVA templates are recommended to meet the minimum requirements for nodes that
run the Administration or Monitoring persona.

If you need to customize the disk size, CPU, or memory allocation, you can manually deploy Cisco ISE using
the standard .iso image. However, it is important that you ensure the minimum requirements and resource
reservations specified in this document are met. The OVA templates simplify ISE virtual appliance deployment
by automatically applying the minimum resources required for each platform.

Table 4: OVA template reservations

Memory
reservation (in
GB)

Memory (in
GB)

CPU
reservation (in
GHz)

Number of
CPUs

OVA template type

No reservation.16No
reservation.

4Evaluation

323288Extra Small

32321616Small (SNS 3615)

96962424Medium (SNS 3655)

2562562424Large (SNS 3695)

32322424Small (SNS 3715)

96964040Medium (SNS 3755)

2562564040Large (SNS 3795)

64643232Small (SNS 3815)

1281284848Medium (SNS 3855)

2562564848Large (SNS 3895)

You can enable only the PSN persona on Extra Small VM. PAN and MnT personas are not supported for this
node.

Note

Reserve CPU and memory resources to match the required allocation. Not reserving enough resources can
significantly affect ISE performance and stability.

This table lists the VMware virtual machine requirements.
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Table 5: VMware virtual machine requirements

SpecificationsRequirement type

CPU
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SpecificationsRequirement type

• Evaluation

• Clock speed: 2.0 GHz or faster

• Number of CPU cores: 4 CPU cores

• Production

• Clock speed: 2.0 GHz or faster

• Number of cores:

• SNS 3600 series appliance:

• Extra Small: 8

• Small: 16

• Medium: 24

• Large: 24

Note
The number of cores is twice that found
in the equivalent Cisco SNS 3600 series
because of hyperthreading. For example,
in a small network deployment, you
must allocate 16 vCPU cores to meet
the CPU specification of SNS 3615,
which has 8 CPU cores or 16 threads.

• SNS 3700 series appliance:

• Small: 24

• Medium: 40

• Large: 40

Note
The number of cores is twice that found
in the equivalent Cisco SNS 3700 series
because of hyperthreading. For example,
in a small network deployment, you
must allocate 24 vCPU cores to meet
the CPU specification of SNS 3715,
which has 12 CPU cores or 24 threads.

• SNS 3800 series appliance:

• Small: 32

• Medium: 48

• Large: 48
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SpecificationsRequirement type

Note
The number of cores is twice that found
in the equivalent Cisco SNS 3800 series
because of hyperthreading. For example,
in a small network deployment, you
must allocate 32 vCPU cores to meet
the CPU specification of SNS 3815,
which has 16 CPU cores or 32 threads.

• Evaluation: 16 GB

• Production

• Extra Small: 32 GB

• Small:

• 32 GB for SNS 3615 and SNS 3715

• 64 GB for SNS 3815

• Medium:

• 96 GB for SNS 3655 and SNS 3755

• 128 GB for SNS 3855

• Large: 256 GB for SNS 3695, SNS 3795, and SNS
3895

Memory

• Evaluation: 300 GB

• Production

300 GB to 2.4 TB of disk storage (size depends on
deployment and tasks).

We recommend that your VM host server use hard disks
with a minimum speed of 10,000 RPM.

Note
When you create the VM for Cisco ISE, use a single virtual
disk that meets the storage requirement. If you use more than
one virtual disk to meet the disk space requirement, the
installer may not recognize all the disk space.

Hard disks
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SpecificationsRequirement type

The storage system for the Cisco ISE virtual appliance
requires a minimumwrite performance of 50MB per second
and a read performance of 300 MB per second. Deploy a
storage system that meets these performance criteria and is
supported by VMware server.

You can use the show tech-support command to view the
read and write performance metrics.

We recommend the VMFS file system because it is most
extensively tested, but other file systems, transports, and
media can also be deployed provided they meet the above
requirements.

Storage and file system

Paravirtual or LSI Logic Parallel

For best performance and redundancy, a caching RAID
controller is recommended. Additionally, battery-backed
controller cache can significantly improve write operations.

Note
Updating the disk SCSI controller of a Cisco ISE VM from
another type to VMware Paravirtual may render it not
bootable.

Disk controller

1 NIC interface required (two or more NICs are
recommended; six NICs are supported).

Cisco ISE supports E1000E and VMXNET3 adapters.

Note
You have to remap the ESXi adapter to synchronize it with
the Cisco ISE adapter order.

NIC

• OVA templates: VMware version 14 or higher on ESXi
6.7, ESXi 7.0, and ESXi 8.0.

• ISO file supports ESXi 6.7, ESXi 7.0, and ESXi 8.0.

VMware virtual hardware version/Hypervisor

Incorrect configuration of VMware High Availability (HA) or Distributed Resource Scheduler (DRS) policies
may trigger false host failure events, which can cause ESXi to restart your Cisco ISE virtual machines
unexpectedly. To maintain deployment stability and prevent Cisco ISE service disruption, ensure that your
VMware virtual machines are configured according to VMware recommendations.
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Linux KVM requirements
Table 6: Linux KVM requirements

Minimum requirementsRequirement type

CPU
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Minimum requirementsRequirement type

• Evaluation

• Clock speed: 2.0 GHz or faster

• Number of cores: 4 CPU cores

• Production

• Clock speed: 2.0 GHz or faster

• Number of cores:

• SNS 3600 series appliance:

• Extra Small: 8

• Small: 16

• Medium: 24

• Large: 24

Note
The number of cores is twice that of an
equivalent Cisco SNS 3600 series appliance,
due to hyperthreading. For example, for a small
network deployment, you must allocate 16
vCPU cores to match the CPU specification of
SNS 3615, which has 8 CPU cores or 16
threads.

• SNS 3700 series appliance:

• Small: 24

• Medium: 40

• Large: 40

Note
The number of cores is twice that of an
equivalent Cisco SNS 3700 series appliance,
due to hyperthreading. For example, for a small
network deployment, you must allocate 24
vCPU cores to meet the CPU specification of
SNS 3715, which has 12 CPU cores or 24
threads.

• SNS 3800 series appliance:

• Small: 32

• Medium: 48

• Large: 48
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Minimum requirementsRequirement type

Note
The number of cores is twice that of an
equivalent Cisco SNS 3800 series appliance,
due to hyperthreading. For example, for a small
network deployment, you must allocate 32
vCPU cores to match the CPU specification of
SNS 3815, which has 16 CPU cores or 32
threads.

• Evaluation: 16 GB

• Production

• Extra Small: 32 GB

• Small:

• 32 GB for SNS 3615 and SNS 3715

• 64 GB for SNS 3815

• Medium:

• 96 GB for SNS 3655 and SNS 3755

• 128 GB for SNS 3855

• Large: 256 GB for SNS 3695, SNS 3795, and SNS 3895

Memory

• Evaluation: 300 GB

• Production

300 GB to 2.4 TB of disk storage (size depends on deployment
and tasks).

We recommend using hard disks with a minimum speed of
10,000 RPM on your VM host server.

Note
When you create the VM for Cisco ISE, use a single virtual
disk that meets the storage requirement. If you use multiple
virtual disks to meet disk space requirements, the installer
might fail to detect the total disk space.

Hard disks

Disk bus - virtio, cache mode - none, I/O mode - native

Use preallocated RAW storage format.

KVM Disk Device

Cisco Identity Services Engine Installation Guide, Release 3.4
21

Cisco Secured Network Server Series Appliances and Virtual Machine Requirements
Linux KVM requirements



Minimum requirementsRequirement type

1 NIC interface required (two or more NIC interfaces are
recommended; six NIC interfaces are supported).

Cisco ISE supports VirtIO drivers. We recommend VirtIO drivers
for better performance.

NIC

KVM on QEMU 2.12.0-99 or aboveHypervisor
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Microsoft Hyper-V requirements
Table 7: Microsoft Hyper-V requirements

Minimum requirementsRequirement
type

CPU

Cisco Identity Services Engine Installation Guide, Release 3.4
23

Cisco Secured Network Server Series Appliances and Virtual Machine Requirements
Microsoft Hyper-V requirements



Minimum requirementsRequirement
type

• Evaluation

• Clock speed: 2.0 GHz or faster

• Number of cores: 4 CPU cores

• Production

• Clock speed: 2.0 GHz or faster

• Number of cores:

• SNS 3600 series appliance:

• Extra Small: 8

• Small: 16

• Medium: 24

• Large: 24

Note
The number of cores is twice that of the equivalent Cisco SNS 3600
series, due to hyperthreading. For example, for a small network
deployment, you must allocate 16 vCPU cores to meet the CPU
specification of SNS 3615, which has 8 CPU cores or 16 threads.

• SNS 3700 series appliance:

• Small: 24

• Medium: 40

• Large: 40

Note
The number of cores is twice that of the equivalent Cisco SNS 3700
series, due to hyperthreading. For example, for a small network
deployment, you must allocate 24 vCPU cores to meet the CPU
specification of SNS 3715, which has 12 CPU cores or 24 threads.

• SNS 3800 series appliance:

• Small: 32

• Medium: 48

• Large: 48

Note
The number of cores is twice that of the equivalent Cisco SNS 3800
series, due to hyperthreading. For example, for a small network
deployment, you must allocate 32 vCPU cores to meet the CPU
specification of SNS 3815, which has 16 CPU cores or 32 threads.
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Minimum requirementsRequirement
type

• Evaluation: 16 GB

• Production

• Extra Small: 32 GB

• Small:

• 32 GB for SNS 3615 and SNS 3715

• 64 GB for SNS 3815

• Medium:

• 96 GB for SNS 3655 and SNS 3755

• 128 GB for SNS 3855

• Large: 256 GB for SNS 3695, SNS 3795, and SNS 3895

Memory

• Evaluation: 300 GB

• Production

300 GB to 2.4 TB of disk storage (size depends on deployment and tasks).

We recommend that your VM host server use hard disks with a minimum speed of
10,000 RPM.

Note
Create the VM for Cisco ISE with a single virtual disk that meets the storage requirement.
If you use multiple virtual disks, the installer may not detect the total disk space.

Hard disks

1 NIC interface required (two or more NICs are recommended, and six NICs are supported).NIC

Hyper-V (Microsoft)Hypervisor

Cisco ISE supports Azure Stack HCI 23H2 and later versions. The virtual machine requirements and the
installation procedure for the Cisco ISE VMs in the Azure Stack HCI are the same as that of Microsoft
Hyper-V.

Note

Nutanix AHV requirements

You must deploy Cisco ISE on Nutanix AHV using the standard .iso image. Do not attempt to deploy or
import Cisco ISE OVA templates into Nutanix AHV. Doing so breaks the system's SMBIOS generation,
resulting in an unsupported UDI and permanently preventing the node from being licensed.

Caution
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This table specifies the recommended resource reservations for different types of deployment on Nutanix
AHV:

Hard disksMemory
reservation (in
GB)

Memory (in
GB)

CPU
reservation

Number of
CPUs

Type

300 GBNo reservation16No reservation4Evaluation

300 GB323288Extra Small

600 GB32321616Small

1.2 TB96962424Medium

2.4 TB (4*600 GB)2562562424Large

Note these points when deploying Cisco ISE on Nutanix AHV:

• Memory is automatically reserved by default. Assign the amount specified in the Cisco ISE sizing table.
No additional configuration is required.

• Nutanix AHV does not support CPU reservation features. There is no MHz or GHz guarantee, and no
options for cpu_reservation or cpu_shares in the GUI or CLI across all AOS versions.

• Nutanix AHV uses fair-share scheduling. CPU time is allocated proportionally based on the number of
vCPUs assigned to each VM. For example, a VM with 24 vCPUs receives approximately three times
the CPU time of a VM with 8 vCPUs.

Follow these guidelines to ensure optimal performance:

• Keep the total number of vCPUs on a host at or below the number of physical cores to avoid CPU
oversubscription

• Avoid placing CPU-intensive or unpredictable workloads on the same host as Cisco ISE to protect
ISE performance.

You must do these configurations on Nutanix AHV before you install Cisco ISE:

• Create a VM on Nutanix AHV and keep the VM powered off.

• If you are using AOS 6.8 or earlier versions, access the Nutanix CVM using ssh login and run these
commands:

• <acropolis> vm.serial_port_create <Cisco ISE VM Name> type=kServer index=0

• <acropolis> vm.update <Cisco ISE VM Name> disable_branding=true

• <acropolis> vm.update <Cisco ISE VM Name> disable_hyperv=true

If you are using AOS 7.0, access the Nutanix CVM using ssh login and run these commands:

• <acropolis> vm.serial_port_create <Cisco ISE VM Name> type=kServer index=0

• <acropolis> vm.update <Cisco ISE VM Name> disable_branding=true

• Exit Acropolis CLI, power on the VM, and install Cisco ISE using the standard .iso image.
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Table 8: Nutanix AHV requirements

Minimum requirementsRequirement type

• Evaluation:

• Clock speed: 2.0 GHz or faster

• Number of cores: 2 CPU cores

• Production:

• Clock Speed: 2.0 GHz or faster

• Number of Cores

• Extra Small: 8 processors (4 cores with hyperthreading enabled)

• Small: 16 processors (8 cores with hyperthreading enabled)

• Medium: 24 processors (12 cores with hyperthreading enabled)

• Large: 24 processors (12 cores with hyperthreading enabled)

Cisco ISE supports hyperthreading. We recommend that you enable hyperthreading,
if it is available.

Note
Hyperthreading can improve overall performance, but supported scaling limits for
each virtual machine appliance remain unchanged. Allocate CPU resources based
on the required number of physical cores instead of logical processors.

CPU

• Evaluation:

• Basic: 4 GB (for evaluating guest access and basic access policy flows)

• Advanced: 16 GB (for evaluating advanced features such as pxGrid, Internal
CA, SXP, Device Administration, and Passive Identity Services)

• Production:

• Extra Small: 32 GB

• Small: 32 GB

• Small: 96 GB

• Large: 256 GB

Memory
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Minimum requirementsRequirement type

• Evaluation: 300 GB

• Production:

300 GB to 2 TB of disk storage (size depends on deployment and tasks).

We recommend that your VM host server use hard disks with a minimum speed
of 10,000 RPM.

Note
You must use four 600 GB hard disks for 2.4 TB hard disk support.

Hard disks

Disk bus - SCSIKVM disk device

1 GB NIC interface required (two or more NICs are recommended; six NICs are
supported).

Cisco ISE supports VirtIO drivers. We recommend VirtIO drivers for better
performance.

NIC

AOS - 6.8 and 7.0, Nutanix AHV - 10.0Hypervisor

Red Hat OpenShift requirements
You can deploy Cisco ISE release 3.4 patch 4 and later VMs on Red Hat OpenShift Virtualization platform.
This enables you to manage both VM and container workloads on a single platform.

Review these requirements before you deploy a Cisco ISE VM on Red Hat OpenShift platform.

• Cisco ISE must be deployed on OpenShift platform using the standard Cisco ISE ISO image. Deploying
Cisco ISE using OVA templates is not supported.

• Cisco ISE supports Red Hat OpenShift container platform 4.19 and later versions.

• You must install the OpenShift Virtualization plug-in to deploy Cisco ISE.

• You must install the OpenShift Container Network Interface (CNI) for network configuration.

Ensure you meet these prerequisites before installing Cisco ISE on OpenShift platform:

• Create the storage infrastructure for Cisco ISE on OpenShift platform. Configure persistent volumes,
storage classes, and persistent volume claims to meet CPU, memory, and other resource requirements
for Cisco ISE VMs.

• Create a bootable volume for the Cisco ISE ISO file. Choose Bootable Volume > Add Volume > ISO
image and upload the Cisco ISE ISO file. Enter the required details in theVolume Mode,Access Mode,
Volume Name, and Preferences fields and then click Save.

• Configure a secondary-VLAN interface. Choose Networking > Network Attachment Definitions and
create a secondary network.

Do not use the pod network for Cisco ISE configuration.

Cisco Identity Services Engine Installation Guide, Release 3.4
28

Cisco Secured Network Server Series Appliances and Virtual Machine Requirements
Red Hat OpenShift requirements



• Create YAML files to configure a VM. In the YAML file, specify the VM settings such as CPU cores,
disks, and boot order.

• ChooseVirtualization > Overview > Create Virtual Command Line Tools and use the oc and virtctrl
OpenShift Command Line Interface utilities to create partitions based on Cisco ISE VM resource
requirements.

You can also create a pod to upload the ISO file.

• Ensure that the persistent volume claims and VM are on the same node.

Choose Virtual Machine > Create > YAML file to create a VM. You can monitor the installation progress
from the Console > VNC page.

The installation process for Cisco ISE on OpenShift platform is the same as on other VM platforms. For
information on how to install Cisco ISE using the ISO image, see Install Cisco ISE using Cisco Integrated
Management Interface, on page 35.

You must use only this ISO file for Cisco ISE release 3.4 to support the Red Hat OpenShift platform:

ise-3.4.0.608b.SPA.x86_64.iso

Note

VMware cloud solutions for Cisco ISE
On any public cloud platform, configure your VPN to allow the VMware engine to connect to on-premises
deployments and to other required devices and services. You can deploy Cisco ISE on VMware cloud solutions
using these public cloud platforms:

• VMware Cloud on Amazon Web Services (AWS): Host Cisco ISE on a software-defined data center
provided by VMware Cloud on AWS. Configure the appropriate security group policies on VMware
Cloud (in theNetworking and Security > Security >Gateway Firewall Settings page) to allow access
to on-premises deployments and other required devices and services.

• Azure VMware Solution: Azure VMware Solution runs VMware workloads natively onMicrosoft Azure.
You can host Cisco ISE as a VMware virtual machine.

• Google Cloud VMware Engine: The Google Cloud VMware Engine runs software-defined data centers
by VMware. You can host Cisco ISE as a VMware virtual machine using the VMware Engine.

For more information on deploying Cisco ISE on cloud platforms, see Deploy Cisco Identity Services Engine
Natively on Cloud Platforms.

Virtual machine size recommendations
The VM appliance specifications should match those of physical appliances used in a production environment.

Follow these guidelines when allocating resources for the appliance:

• Do not share or oversubscribe resources across multiple guest VMs. Use OVF templates to assign adequate
resources. If you install Cisco ISE manually using the ISO image, ensure you assign equivalent
reservations.
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If you do not allocate the specified resources, performance degradation or service failure might occur.
To avoid these issues, deploy dedicated VM resources.

If you deploy Cisco ISE manually without the recommended reservations, you must closely monitor
your appliance’s resource utilization. Increase resources as needed to ensure proper health and functioning
of the Cisco ISE deployment.

• If you are using the OVA templates for installation, check these settings in the Edit Settings page (under
the Virtual Hardware tab), after the installation is complete:

• Ensure that you assign the resource reservations that are specified in the VMware virtual machine
requirements, on page 13 section in the CPU/Memory Reservation field to ensure proper health
and functioning of the Cisco ISE deployment.

• Ensure that the CPU usage in theCPU Limit field is set toUnlimited. Setting a limit for CPU usage
impacts system performance. If a limit is set, shut down the VM client, remove the limit, and restart
the client.

• Ensure that the memory usage in the Memory Limit field is set to Unlimited. Setting a limit for
memory usage will impact the system performance.

• Ensure that the Shares option is set as High in the Hard Disk area.

Admin andMnT nodes rely heavily on disk usage. Using shared disk storage VMware environment
might degrade disk performance. You must increase the number of disk shares allocated to a node
to improve performance.

• You can deploy Policy Service nodes on VMs with less disk space than Administration or Monitoring
nodes. The minimum disk space for any production Cisco ISE node is 300 GB.

• VMs can be configured with one to six NICs. Configure VMs with at least two NICs when possible.
Additional interfaces support services such as profiling, guest services, or RADIUS.

If you decrease the RAM or CPU allocation for a VM, you must reimage Cisco ISE with the new VM
configuration. However, increasing the RAM or CPU capacity does not require reimaging.

Note

Disk space requirements for VMs in a Cisco ISE deployment
This table provides the recommended Cisco ISE disk-space allocation for running a VM in a production
deployment.

To boot a GPT partition with 2 TB or more, change the firmware from BIOS to EFI in the VM settings boot
mode.

Note
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Table 9: Recommended disk space for VMs

Maximum disk
space

Recommended disk
space for production

Minimum disk
space for
production

Minimum disk
space for
evaluation

Cisco ISE persona

2.4 TB600 GB to 2.4 TB600 GB300 GBStandalone Cisco ISE

2.4 TB600 GB600 GB300 GBDistributed Cisco ISE,
Administration only

2.4 TB600 GB to 2.4 TB600 GB300 GBDistributedCisco ISE,Monitoring
only

2.4 TB300 GB300 GB300 GBDistributed Cisco ISE, Policy
Service only

2.4 TB300 GB300 GB300 GBDistributed Cisco ISE, pxGrid
only

2.4 TB600 GB to 2.4 TB600 GB300 GBDistributed Cisco ISE,
Administration and Monitoring
(and optionally, pxGrid)

2.4 TB600 GB to 2.4 TB600 GB300 GBDistributed Cisco ISE,
Administration, Monitoring, and
Policy Service (and optionally,
pxGrid)

Additional disk space is required to store local debug logs and staging files. Extra space is also needed to
handle log data during an upgrade, when the Primary Administration node temporarily becomes aMonitoring
node.

Note

Disk space guidelines for Cisco ISE
Consider these guidelines when determining the disk space for Cisco ISE:

• Cisco ISE must be installed on a single disk in a VM.

• Disk allocation varies based on logging retention requirements. On any node that has the Monitoring
persona enabled, 60 percent of the VM disk space is allocated for log storage. A deployment with 25,000
endpoints generates approximately 1 GB of logs per day.

For example, if you have a Monitoring node with 600 GB VM disk space, 360 GB is allocated for log
storage. If 100,000 endpoints connect to this network every day, it generates approximately 4 GB of logs
per day. In this case, you can store 76 days of logs in the Monitoring node, after which you must transfer
the old data to a repository and purge it from the Monitoring database.

For extra log storage, you can increase the VM disk space. For every 100 GB of disk space that you add, you
get 60 GB more for log storage.
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If you increase the disk size of your virtual machine after initial installation, perform a fresh installation of
Cisco ISE. This ensures that Cisco ISE properly detects and uses the full disk allocation.

This table shows the retention period for RADIUS logs on your Monitoring node based on disk space and
endpoint count. These values are based on these assumptions: Ten or more authentications per day per endpoint
with logging suppression enabled.

Table 10: Monitoring node log storage (retention period in days for RADIUS)

2048 GB1024 GB600 GB300 GBNumber of endpoints

5154257715105045,000

2577128975525210,000

103151630210125,000

5162581515150,000

2581297626100,000

172865117150,000

129653813200,000

104523111250,000

5226166500,000

This table shows the TACACS+ log retention period on your Monitoring node based on disk space and
endpoint count. These values are based on these assumptions: The script runs against all NADs, 4 sessions
per day, and 5 commands per session.

Table 11: Monitoring node log storage (retention period in days for TACACS+)

2048 GB1024 GB600 GB300 GBNumber of endpoints

128,85064,42537,74912,583100

25,77012,8857,5502,517500

12,8856,4433,7751,2591,000

2,5771,2897552525,000

1,28964537812610,000

5162581515125,000

258129762650,000

17286511775,000

129653813100,000
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Increase disk size

If the context and visibility functions are slow or storage space for logs is not sufficient, you must allocate
more disk space.

For every 100 GB of disk space that you add, 60 GB is available for log storage.

To enable Cisco ISE to detect and use the new disk allocation, you must deregister the node, update the VM
settings, and reinstall Cisco ISE. You can install Cisco ISE on a new, larger node and add that node to the
deployment for high availability. After synchronizing the nodes, configure the new VM as the primary node
and deregister the original VM.

Decrease disk size

If you reduce the VM reservations after installing Cisco ISE, you must perform these steps:

1. Perform a backup of Cisco ISE.

2. Re-image Cisco ISE with the updated VM configuration.

3. Restore Cisco ISE.

CPU requirements for hypervisors
From Cisco ISE release 3.4, several Cisco ISE services run inside containers based on RHEL 9.3. RHEL 9.3
requires a minimum CPU architecture of x86-64-v2.

If your hypervisor presents a CPU baseline below x86-64-v2 to the guest VM, the affected containers fail to
start. The Cisco ISE GUI and CLI show the processes that require x86-64-v2 (Cisco ISE release 3.4 and later)
as not running or initializing :

• ISE pxGrid Direct Service

• ISE pxGrid Direct Pusher

• Hermes (pxGrid Cloud Agent)

• McTrust (Meraki Sync Service)

• ACI Connector

• MFC Profiler

To verify whether your hypervisor exposes the required CPU flags, run this command from the Cisco ISE
CLI admin or root shell:

To verify x86-64-v2 support (including SSE4.2 and POPCNT), use this command:

show tech-support | include sse4_2

If the output is empty, the hypervisor is masking the required CPU features, which prevents affected services
from starting.

If the output includes these flags, your VM detects the modern CPU instruction sets exposed by the hypervisor.
For example, if sse4_2 and popcnt are present, the guest VM receives the x86-64-v2 instruction set from the
hypervisor. This instruction set is required for RHEL 9-based ISE containers.

If these strings are missing, your hypervisor masks the CPU features required by Cisco ISE.
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If the physical CPU supports these instruction sets, you can enable or expose them to the VM using these
hypervisor-specific settings:

• ESXi: Enable Expose hardware-assisted virtualization to the guest OS.

• Hyper-V: Disable Migrate to a physical computer with a different processor version. Migration to
another physical host remains supported if the CPU vendor and processor generation are the same.

• KVM, Proxmox, or Nutanix: Change the CPU type from default to host.
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C H A P T E R 3
Install Cisco ISE

• Install Cisco ISE using Cisco Integrated Management Interface, on page 35
• Run the setup program of Cisco ISE, on page 38
• Verify the Cisco ISE installation process, on page 40
• Install Cisco ISE from an ISO on OpenStack, on page 41
• Install Cisco ISE on a Cisco SNS appliance using NFS, on page 44
• Localized ISE installation, on page 44

Install Cisco ISE using Cisco Integrated Management Interface
Use these high-level steps to install Cisco ISE.

Before you begin

• Verify that your system meets the System Requirements.

• For virtual machine installations, create the VM according to the specified configuration. Refer to these
topics for more information.

• For SNS hardware appliances, set up Cisco Integrated Management Interface (Cisco IMC) to manage
the appliance and configure BIOS. Refer to the respective hardware installation guides:

• SNS-3600 Series: Cisco SNS-3600 Series Appliance Hardware Installation Guide

• SNS-3700 Series: Cisco SNS-3700 Series Appliance Hardware Installation Guide

• SNS-3800 Series: Cisco SNS-3800 Series Appliance Hardware Installation Guide

Procedure

Step 1 Installation Overview

• For Cisco SNS Appliances

a. Install the hardware appliance.

b. Connect to Cisco IMC for server management.
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• For Virtual Machines

a. Confirm your VM configuration matches the requirements.

Step 2 Download Software: Download the Cisco ISE ISO image.
a) Go to http://www.cisco.com/go/ise. You need valid Cisco.com login credentials to access the site.
b) Click Download Software for this Product.

The Cisco ISE image includes a pre-installed 90-day evaluation license, which enables you to test all Cisco ISE
services after completing installation and initial configuration.

Step 3 Booting the appliance or VM

• Cisco SNS appliance:

a. Connect to Cisco IMC and log in using the Cisco IMC credentials.

b. Launch the KVM console.

c. Select Virtual Media > Activate Virtual Devices.

d. Select Virtual Media > Map CD/DVD, select the Cisco ISE ISO image, and click Map Device.

e. Select Macros > Static Macros > Ctrl-Alt-Del to boot the appliance with the Cisco ISE ISO image.

f. Press F6 to open the boot menu. A similar screen appears:

Figure 6: Selection of boot device

Note
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For remote SNS appliances without physical access, installation through Cisco IMC may take several hours. To
speed up installation, copy the ISO file to a USB drive and use it during installation.

Installation timemay vary (approximately 30 minutes) depending on network speed, stability, TCP segmentation,
and operating system factors.

If the system enters an emergency shell during initial boot due to incomplete hardware initialization, reboot to
allow initialization to complete and continue installation.

• Virtual Machine:

a. Map the CD/DVD to an ISO image. A similar screen appears. The installation menu appears with the message.
Welcome to the Cisco Identity Services Engine Installer
Cisco ISE Version: 3.x.x.xxx

Available boot options:

Cisco ISE Installation (Serial Console)
Cisco ISE Installation (Keyboard/Monitor)
System Utilities (Serial Console)
System Utilities (Keyboard/Monitor)

Step 4 At the boot prompt, press 1 and Enter to install Cisco ISE using a serial console.

If you want to use a keyboard and monitor, use the arrow key to select the Cisco ISE Installation (Keyboard/Monitor)
option. The message appears.
**********************************************
Please type 'setup' to configure the appliance
**********************************************

Step 5 Setup program: At the prompt, type setup to start the setup program. See Run the setup program of Cisco ISE, on page
38 for details about the parameters that the setup program uses.

Step 6 After you enter the network configuration parameters in the setup mode, the appliance automatically reboots, and returns
to the shell prompt mode.

Step 7 Exit shell prompt mode. The appliance starts.
Step 8 Proceed to Verify the Cisco ISE installation process, on page 40.

Installation metrics for Cisco ISE
The table outlines the installation duration and network latency metrics for various mount types for Cisco
ISE.

Table 12: Latency and installation metrics for Cisco ISE

Approximate latencyTime taken for
installation

Mount type

Average round-trip time is less than 1 millisecond7 hoursNFS-CIMC Mount
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-4 hoursCD or DVD - KVM
Mount

-1 hourUSB

Run the setup program of Cisco ISE
This section explains how to configure the Cisco ISE server. The interactive command-line interface (CLI)
helps you configure network settings, administrator credentials, and management interfaces. It supports IPv4,
IPv6, and dual-stack configurations and covers integration with Active Directory (AD) and essential parameters
such as hostname, IP addresses, DNS, NTP servers, and system time zone.

The setup program launches an interactive CLI that prompts you for required parameters. Use the console or
a dumb terminal to configure the initial network settings and administrator credentials for the Cisco ISE server.
You only need to perform this setup process once. For AD integration, use IP and subnet addresses from a
dedicated site created for Cisco ISE. Contact your organization's AD staff to obtain the IP and subnet addresses
for your Cisco ISE nodes before installation and configuration.

Follow these steps to run the setup program.

Procedure

Step 1 Power on the appliance designated for the installation.

The setup prompt appears:
Type 'setup' to configure the appliance
localhost login:

Step 2 At the setup prompt, enter setup and press Enter.

The console displays a set of parameters. Enter the parameter values for each prompt in the table.

Note
The eth0 interface of Cisco ISE must be statically configured with an IPv6 address if you want to add a Domain Name
Server or an NTP Server with an IPv6 address.

Table 13: Cisco ISE setup program parameters

ExampleDescriptionPrompt

isebeta1Up to 19 characters; alphanumeric and hyphen only; first character
must be a letter.

Note
Use lowercase to avoid certificate issues. Do not use "localhost"
as hostname for a node.

Hostname

10.12.13.14/
2001:420:54ff:4::458:121:119

Valid IPv4 or global IPv6 for the Gigabit Ethernet 0 (eth0)
interface.

(eth0) Ethernet interface
address
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ExampleDescriptionPrompt

255.255.255.0/
2001:420:54ff:4::458:121:119/122

Valid IPv4 or IPv6 netmask.Netmask

10.12.13.1/
2001:420:54ff:4::458:1

Valid IPv4 or global IPv6 address for the default gateway.Default gateway

example.comMust not be an IP address. Valid characters include ASCII
characters, any numerals, the hyphen (-), and the period (.).

Note
The top-level domain name must not exceed 6 characters in
length. If the TLD length exceeds six characters, Cisco ISE will
become unusable.

DNS domain name

10.15.20.25 /
2001:420:54ff:4::458:118

Valid IPv4 or global IPv6 address for the primary name server.Primary name server

(Optional) Allows you
to configure multiple
name servers. To
configure multiple
name servers, enter y
to continue.

Valid IPv4 or global IPv6 address for the primary name server.Add/Edit another name
server

clock.nist.gov /
10.15.20.25 /
2001:420:54ff:4::458:117

Valid IPv4 or global IPv6 address or hostname of a Network Time
Protocol (NTP) server.

Note
Ensure that the primary NTP server is reachable.

Primary NTP server

(Optional) Allows you
to configure multiple
NTP servers. To do so,
enter y to continue.

Must be a valid NTP domain.Add/Edit another NTP
server

UTC (default)Must be a valid time zone. For example, for Pacific Standard
Time (PST), the System Time Zone is PST8PDT, which is
Coordinated Universal Time (UTC) minus 8 hours (UTC–08:00
or 16:00).

Note
Ensure that the system time and time zone match the CIMC or
Hypervisor Host OS time and time zone. If there is any mismatch
between the time zones, system performance might be affected.

Note
Set all Cisco ISE nodes to the UTC time zone. This setting
ensures that reports, logs, and posture agent log files from the
nodes in your deployment are always synchronized by timestamp.

System Time Zone
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ExampleDescriptionPrompt

admin (default)Identifies the administrative username used for CLI access to the
Cisco ISE system. If you choose not to use the default (admin),
you must create a new username. The Username must be 3 to 8
characters in length and consist of valid alphanumeric characters
(A–Z, a–z, or 0–9).

Username

MyIseYPass2Identifies the administrative password that is used for CLI access
to the Cisco ISE system. You must create this password in order
to continue because there is no default password. The password
must be a minimum of six characters in length and include at least
one lowercase letter (a–z), one uppercase letter (A–Z), and one
numeral (0–9).

Password

Note
• If you create a password that includes the $ character anywhere except as the last character, the system accepts the
password, but you cannot log in to the CLI with it.

• To reset such a password, log into the console and use CLI commands or reset using an ISE CD or ISO file. Refer
to the Cisco ISE password reset documentation for instructions.

After the setup

• The system reboots automatically after completing the setup.

• Log in to Cisco ISE using the configured username and password.

Verify the Cisco ISE installation process
Use this procedure to confirm successful installation.

Procedure

Step 1 When the system reboots and the login prompt appears, enter the username you configured during setup. Then press
Enter.

Step 2 Enter a new password.
Step 3 To verify that the application has been installed properly, enter the show application command. Then press Enter.

The console displays:
ise/admin# show application
<name> <Description>
ise Cisco Identity Services Engine

Note
The version and date might change for different versions of this release.
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Step 4 To check the status of the ISE processes, enter the show application status ise command, and press Enter.
The console displays:
ise/admin# show application status ise

ISE PROCESS NAME STATE PROCESS ID
--------------------------------------------------------------------
Database Listener running 14890
Database Server running 70 PROCESSES
Application Server running 19158
Profiler Database running 16293
ISE Indexing Engine running 20773
AD Connector running 22466
M&T Session Database running 16195
M&T Log Collector running 19294
M&T Log Processor running 19207
Certificate Authority Service running 22237
EST Service running 29847
SXP Engine Service disabled
Docker Daemon running 21197
TC-NAC Service disabled
pxGrid Infrastructure Service disabled
pxGrid Publisher Subscriber Service disabled
pxGrid Connection Manager disabled
pxGrid Controller disabled
PassiveID WMI Service disabled
PassiveID Syslog Service disabled
PassiveID API Service disabled
PassiveID Agent Service disabled
PassiveID Endpoint Service disabled
PassiveID SPAN Service disabled
DHCP Server (dhcpd) disabled
DNS Server (named) disabled

ise/admin#

Install Cisco ISE from an ISO on OpenStack
You can install Cisco ISE release 3.4 patch 4 and later releases in an OpenStack environment using these
methods:

• OpenStack Dashboard (for example, Horizon): A web-based interface that allows administrators to
manage OpenStack resources and services, including the deployment of Cisco ISE instances.

• OpenStack Orchestration Tools (for example, HEAT): Templates that define the network, compute, and
storage topology for automated deployment and management of Cisco ISE virtual machines.

• OpenStack Command Line Interfaces (CLI): Command-line tools that provide granular control over
deploying and managing Cisco ISE instances within OpenStack.

This section provides a sample CLI-based Cisco ISE installation procedure in an OpenStack environment.

Follow these steps to install Cisco ISE using OpenStack CLI.
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Procedure

Step 1 Create a custom flavor in OpenStack that matches the Cisco ISE appliance size requirements.

Here is a sample command for Cisco SNS 3715 to create a flavor named "sns3715-openstack" with 32 GB RAM, 300
GB disk, and 24 virtual CPUs, with an automatically assigned ID.

openstack flavor create sns3715-openstack --id auto --ram 32768 --disk 300 --vcpus 24

For information about the Cisco SNS appliance size requirements, refer to Cisco SNS Appliance Hardware Installation
Guide.

This process takes about 5 to 10 minutes.

You need this flavor name when creating the bootable VM instance.

Step 2 Create the Glance image for Cisco ISE installation.

• Follow these steps to create the Glance image using the ISO file:

a. Create a blank Cinder volume for the VM's main hard drive using this command:

openstack volume create --size <volume_size_in_GB> <volume_name>

Ensure that the volume size meets Cisco ISE specifications.

b. Create a temporary VM to copy the Cisco ISE filesystem onto the blank volume using this command:

openstack server create --image <iso-image-name-or-id> --volume <volume_name> --flavor

<custom-flavor-name> --network <network-name> <temp-ise-install-vm-name>

Attach both the blank Cinder volume and the installation ISO to the VM.

This process takes about 5 minutes.

c. Install the operating system through the VM console.

1. Access the VM console using this command:

openstack console url show <temp-ise-install-vm-name>

2. When the boot menu appears, select [1] Cisco ISE Installation (Keyboard/Monitor) to begin the installation.

The installer writes the operating system to the blank volume. Wait 20 to 30 minutes for installation to
complete.

After installation completes, the console returns to the boot prompt. The volume now contains a bootable
operating system.

d. Set the volume as bootable.

1. Delete the temporary VM to release the volume using this command:

openstack server delete <temp-ise-install-vm-name>

2. Verify that the volume status is "available" using this command:

watch openstack volume show <volume_name>

3. Mark the volume as bootable using this command:
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openstack volume set --bootable <volume_name>

• Follow these steps to create a QCOW2 image, install Cisco ISE using the ISO, and upload the image to OpenStack.

a. Create the QCOW2 image using this command:

qemu-img create -f qcow2 <image_name>.qcow2 <size>

b. Install the Cisco ISE ISO on the QCOW2 image. Run this command to boot the ISO and begin the installation
on the disk image.

/usr/libexec/qemu-kvm -enable-kvm -m <memory_size> -smp <cpu_cores> -cpu host \ -drive

file=<image_name>.qcow2,format=qcow2 \ -cdrom <iso_file_path> \ -boot d -net nic,model=virtio

-net user \ -nographic -serial mon:stdio

c. Perform the installation via the serial console. When the installation menu appears, select 2 to proceed with the
installation using the serial console. Follow the on-screen prompts to complete the setup.

d. Upload the QCOW2 image to OpenStack. After the installation is complete and the image is prepared, use the
OpenStack CLI to create a new image in your environment.

openstack image create --disk-format qcow2 --container-format bare --file <image_file_name>

--private <image_name>

Note
You must use this ISO file for OpenStack support:

ise-3.4.0.608b.SPA.x86_64.iso

Step 3 Create and launch the Cisco ISE server VM with the prepared bootable volume by using this command:

openstack server create --volume <volume_name> --flavor <custom-flavor-name> --network <network-name>

<vm-name>

This process takes approximately 5 minutes.

Step 4 Configure the network settings for the VM.

a. Access the VM console and enter this command at the setup prompt:

setup

b. Follow the prompts to configure the hostname, IP address, and network details.

After you complete the configuration, access the VM using the assigned IP address.

Run these commands to verify the Cisco ISE VM configuration.

• To check inventory, use this command:

show inventory

• To check the profiles, use this command:

show tech | inc profile
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Install Cisco ISE on a Cisco SNS appliance using NFS
This section explains how to install Cisco ISE on a Cisco SNS appliance by using a Network File System
(NFS) server.

Before you begin

• Ensure that you meet the requirements specified in the guide.

• Set up the Cisco Integrated Management Interface (CIMC) configuration utility to manage the appliance
and configure the BIOS. For more information, see these documents:

• For SNS-3600 series appliances, refer to Cisco SNS-3600 Series Appliance Hardware Installation
Guide for details.

• For SNS-3700 series appliances, refer to Cisco SNS-3700 Series Appliance Hardware Installation
Guide for details.

• For SNS-3800 series appliances, refer to Cisco SNS-3800 Series Appliance Hardware Installation
Guide for details.

Procedure

Step 1 Download the Cisco ISE ISO image from http://www.cisco.com/go/ise.
Step 2 Connect to CIMC and log in using the CIMC credentials.
Step 3 Choose Compute > Remote Management > Virtual Media > Add New Mapping, enter the NFS server details in the

Add New Mapping window, and then click Save.
Step 4 Verify that the mapping status shows OK in the Current Mappings window.
Step 5 Launch the KVM console.
Step 6 Choose Power > Power Cycle System and click Confirm to reboot the appliance.
Step 7 Press F6 to enter the boot menu.
Step 8 In the Select Boot Device window, choose UEFI: Cisco CIMC-Mapped vDVD2.00, and press Enter.

The Cisco ISE installation menu appears after the server completes the booting process.

Step 9 Choose Cisco ISE Installation (Keyboard/Monitor) to continue with the installation.

Localized ISE installation
While reinstalling Cisco ISE, you can use the Localized ISE Install option in the application configure ise
command to reduce the installation time. This option reduces the reinstallation time from an average of 5 to
7 hours to approximately 1 to 2 hours. This option can be used for both Secure Network Servers (SNS) and
virtual appliances. However, it significantly reduces the reinstallation time only for SNS.
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• Localized ISE Install option is supported for Cisco ISE release 3.1 patch 9 and later, Cisco ISE release
3.2 patch 5 and later, Cisco ISE release 3.3 patch 2 and later, and Cisco ISE release 3.4 and later releases.

• You can use this option to reinstall the current version and higher versions. You cannot install a version
that is older than the current version.

Note

For more information, see "Localized ISE Installation" in the Chapter "Cisco ISE CLI Commands in EXEC
Mode" in the Cisco Identity Services Engine CLI Reference Guide.

Cisco Identity Services Engine Installation Guide, Release 3.4
45

Install Cisco ISE
Localized ISE installation

https://www.cisco.com/c/en/us/support/security/identity-services-engine/products-command-reference-list.html


Cisco Identity Services Engine Installation Guide, Release 3.4
46

Install Cisco ISE
Localized ISE installation



C H A P T E R 4
Additional Installation Information

• Tools used to create a bootable USB device from Installation ISO File, on page 47
• SNS Appliance Reference, on page 48
• VMware Virtual Machine, on page 50
• Linux KVM, on page 64
• Microsoft Hyper-V, on page 67
• Create a Cisco ISE virtual machine on Hyper-V, on page 67
• Zero Touch Provisioning, on page 82

Tools used to create a bootable USB device from Installation
ISO File

The following table shows the tools to be used to create a bootable USB device from the installation ISO file
in different Cisco ISE versions.

Table 14: Tools Used to Create Bootable USB Device

ToolCisco ISE release

• Rufus for ise-3.4.0.608.SPA.x86_64.iso file

• Rufus, Fedora Media Writer, and balenaEtcher for
ise-3.4.0.608a.SPA.x86_64.iso

Cisco ISE 3.4

RufusCisco ISE 3.3

RufusCisco ISE 3.2

Fedora LiveUSB-creator for SNS 3500 and SNS 3600 series
appliances.

Rufus for SNS 3700 series appliances

Cisco ISE 3.1
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Cisco ISE 3.1 patch 6 and later and Cisco ISE 3.2 patch 2 and later versions support Cisco SNS 3700 series
appliances.

Note

You can download Rufus from this location:

https://rufus.ie/downloads/

You can download Fedora Media Writer from this location:

https://github.com/FedoraQt/MediaWriter/releases/tag/5.0.6

You can download balenaEtcher from this location:

https://github.com/balena-io/etcher/releases/tag/v1.19.21

SNS Appliance Reference

Create a Bootable USB Device Using Rufus

Before you begin

• Download the Cisco ISE installation ISO file to the local system.

• Use a 16 GB or 32 GB USB device.

Procedure

Step 1 Reformat the USB device using FAT16 or FAT32 to free up all the space.
Step 2 Plug in the USB device to the local system and launch Rufus.
Step 3 From the Boot Selection drop-down list, choose Disk or ISO Image.
Step 4 Click Select and choose the Cisco ISE ISO file.

Note
You must use the latest ISO file (ise-3.4.0.608b.SPA.x86_64.iso) for Cisco SNS 3800 appliance support.

Step 5 From the Partition Scheme drop-down list, choose MBR.
Step 6 From the Target System drop-down list, choose BIOS or UEFI.
Step 7 Click Start.

You can view the status of the bootable USB creation in the progress bar. After the process completes, you can access
the contents of the USB drive on your local system.

Step 8 Remove the USB device from the local system safely.
Step 9 Plug in the bootable USB device to the Cisco ISE appliance, restart the appliance, and install Cisco ISE by booting from

the USB drive.
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Create a Bootable USB Device Using Fedora Media Writer

Before you begin

• Download the Cisco ISE installation ISO file to the local system.

You must use the ISO file for Cisco ISE Release 3.4:

ise-3.4.0.608a.SPA.x86_64.iso

• Download Fedora Media Writer from this location:

https://github.com/FedoraQt/MediaWriter/releases/tag/5.0.6

• Use a 16-GB or 32-GB USB device.

• Reformat the USB device using FAT16 or FAT32 to free up all the space.

Procedure

Step 1 Open the Fedora Media Writer application.
Step 2 In the Select Image Source tab, click Select .iso file, choose the ISO file, and click Next.
Step 3 Plug in the USB device to the local system and launch Fedora Media Writer.
Step 4 Choose the ISO file and click Write.

Wait for the process to complete. This process may take several minutes, depending on the speed of your USB device.
When the process finishes, the application displays a notification message.

Step 5 Safely remove the USB device from the local system.
Step 6 Plug the bootable USB device into the Cisco ISE appliance. Restart the appliance. Boot from the USB drive to install

Cisco ISE.

Create a Bootable USB Device Using balenaEtcher

Before you begin

• Download the Cisco Identity Services Engine (ISE) installation ISO file to your local system.

You must use this ISO file for Cisco ISE Release 3.4:

ise-3.4.0.608a.SPA.x86_64.iso

• Download balenaEtcher from this location:

https://github.com/balena-io/etcher/releases/tag/v1.19.21

• Use a 16 GB or 32 GB USB device.

• Reformat your USB device using the FAT-16 or FAT-32 file system to ensure all space is available.
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Procedure

Step 1 Run the balenaEtcher application.
Step 2 Click Flash from file. Choose the ISO file from your local system.

If a Missing Partition Table message appears, click Continue.

Step 3 Click Select Target. Choose the USB device.
Step 4 Click Flash to start the process.

You will see a notification message when the process is complete.

Step 5 Plug in the bootable USB device into the Cisco ISE appliance. Restart the appliance. Boot from the USB drive to install
Cisco ISE.

Reimage the Cisco SNS Hardware Appliance
The Cisco SNS hardware appliances do not have built-in DVD drives. Therefore, to reimage a Cisco ISE
hardware appliance with Cisco ISE software, you can do one of these options:

Cisco SNS hardware appliances support the Unified Extensible Firmware Interface (UEFI) secure boot feature.
This feature ensures that only a Cisco-signed ISE image can be installed on the SNS hardware appliances,
and prevents installation of any unsigned operating system even with physical access to the device. For
example, generic operating systems, such as Red Hat Enterprise Linux or Microsoft Windows cannot boot
on this appliance.

Note

• Use the Cisco Integrated Management Controller (Cisco IMC) interface to map the installation .iso file
to the virtual DVD device.

• Create an install DVD with the installation .iso file. Plug in a USB external DVD drive, then boot the
appliance from the DVD drive.

• Create a bootable USB device using the installation .iso file. Boot the appliance from the USB drive.

VMware Virtual Machine

The VMware form factor instructions provided in this document are also applicable for Cisco Identity Services
Engine (ISE) installed on Hyperflex.

Note
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Virtual Machine Resource and Performance Checks
Before installing Cisco ISE on a virtual machine, the installer performs hardware integrity checks by comparing
the available hardware resources on the virtual machine with the recommended specifications.

During a virtual machine (VM) resource check, the installer verifies the hard disk space, number of CPU
cores, CPU clock speed, and RAM allocated to the VM. If the VM resources do not meet the basic evaluation
specifications, installation terminates. This check applies only to ISO-based installations.

When you run the Setup program, the installer performs a VM performance check for disk I/O. If disk I/O
performance does not meet the recommended specifications, the installer displays a warning, but you can
continue with installation.

The VM performance check is done periodically (every hour), and the results are averaged over one day. If
the disk I/O performance does not meet the recommended specification, an alarm is generated.

The VM performance check can also be done on demand from the Cisco ISE CLI using the show tech-support
command.

You can run VM resource and performance checks outside Cisco ISE installation. Use the Cisco ISE boot
menu to perform these tests.

Install Cisco ISE on VMware Virtual Machine Using the ISO File
This section describes how to install Cisco ISE on a VMware virtual machine using the ISO file.

Prerequisites for Configuring a VMware ESXi Server
Review the following configuration prerequisites listed in this section before you attempt to configure a
VMWare ESXi server:

• Remember to log in to the ESXi server as a user with administrative privileges (root user).

• Cisco ISE is a 64-bit system. Before you install a 64-bit system, ensure that Virtualization Technology
(VT) is enabled on the ESXi server.

• Ensure that you allocate the recommended amount of disk space on the VMware virtual machine.

• If you have not created a VMware virtual machine file system (VMFS), you must create one to support
the Cisco ISE virtual appliance. The VMFS is set for each of the storage volumes configured on the
VMware host. For VMFS5, the 1-MB block size supports up to 1.999 TB virtual disk size.

Virtualization Technology Check

If you already have an ESXi server installed, you can check whether Virtualization Technology (VT) is enabled
without rebooting the machine. Use the esxcfg-info command to perform this check.

~ # esxcfg-info |grep "HV Support"
|----HV Support............................................3
|----World Command Line.................................grep HV Support

If HV Support has a value of 3, VT is enabled on the ESXi server. You can proceed with the installation.

If HV Support has a value of 2, VT is supported, but not enabled on the ESXi server. Edit the BIOS settings
and enable VT on the server.
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Enable Virtualization Technology on an ESXi Server

You can reuse the same hardware that hosted a previous version of the Cisco ISE virtual machine. However,
you must enable Virtualization Technology (VT) on the ESXi server before installing the latest release.

Procedure

Step 1 Reboot the appliance.
Step 2 Press F2 to enter setup.
Step 3 Choose Advanced > Processor Configuration.
Step 4 Select Intel(R) VT and enable it.
Step 5 Press F10 to save your changes and exit.

Configure VMware Server Interfaces for the Cisco ISE Profiler Service

Configure VMware server interfaces to support the collection of Switch Port Analyzer (SPAN) or mirrored
traffic to a dedicated probe interface for the Cisco ISE Profiler Service.

Procedure

Step 1 Choose Configuration > Networking > Properties > VMNetwork (the name of your VMware server
instance)VMswitch0 (one of your VMware ESXi server interfaces) Properties Security.

Step 2 In the Policy Exceptions pane on the Security tab, check the Promiscuous Mode check box.
Step 3 In the Promiscuous Mode drop-down list, choose Accept and click OK.

Perform these steps on any other VMware ESXi server interface that collects SPAN or mirrored profiler traffic.

Connect to the VMware Server Using the Serial Console

Procedure

Step 1 Power off the specific VMware server (for example, ISE-120).
Step 2 Right-click the VMware server, and choose Edit.

Step 3 Click Add on the Hardware tab.
Step 4 Choose Serial Port and click Next.
Step 5 In the Serial Port Output area, select the Use physical serial port on the host radio button or the Connect via Network

radio button and then click Next.

• If you choose the Connect via Network option, you must open the firewall ports over the ESXi server.

• If you select the Use physical serial port on the host, choose the port. You must choose the port. There are two
options available:
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• /dev/ttyS0 (In the DOS or Windows operating system, this appears as COM1).

• /dev/ttyS1 (In the DOS or Windows operating system, this appears as COM2).

Step 6 Click Next.
Step 7 Check the appropriate check box in the Device Status area. By default, Connected is selected.
Step 8 Click OK to connect to the VMware server.

Configure a VMware Server

Before you begin

Ensure that you have read the Prerequisites for configuring a VMware Server.

Procedure

Step 1 Log in to the ESXi server.
Step 2 In the VMware vSphere Client, in the left pane, right-click your host container and choose New Virtual Machine.
Step 3 In the Select a Creation Type area, click Create a new virtual machine and click Next.
Step 4 In the Select a Name and Folder area, enter a name for the VMware system, select a location from the displayed list,

and click Next.

Tip
Use the hostname that you want to use for your VMware host.

Step 5 In the Select a compute resource area, choose a destination compute resource and click Next.
Step 6 In the Select storage area, choose a datastore that has the recommended amount of space available and click Next.
Step 7 In the Select compatibility area, from theCompatible with drop-down list, choose an ESXi version that is compatible

with your Cisco ISE version and click Next.

For information about the ESXi versions compatible with your Cisco ISE release, see "Supported Virtual Environments"
in the Release Notes for Cisco Identity Services Engine for your release.

Step 8 In the Select a guest OS area, complete these steps and then click Next:

a. From the Guest OS Family drop-down list, choose Linux.

b. From the Guest OS Version drop-down list, choose the supported Red Hat Enterprise Linux (RHEL) version.
Cisco ISE Release 3.1 and later use RHEL 8.

Step 9 In the Customize hardware area, in the Virtual Hardware tab, carry out the following configurations and then click
Next.

a. Choose the required values from the CPU and Memory drop-down lists based on the SNS series appliance you
use:

SNS 3600 Series Appliance:

• Small: 16 vCPU cores, 32 GB
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• Medium: 24 vCPU cores, 96 GB

• Large: 24 vCPU cores, 256 GB

The number of cores is twice of that present in equivalent of the Cisco Secure Network Server 3600 series,
due to hyperthreading. For example, in case of Small network deployment, you must allocate 16 vCPU cores
to meet the CPU specification of SNS 3615, which has 8 CPU Cores or 16 Threads.

SNS 3700 Series Appliance:

• Small: 24 vCPU cores, 32 GB

• Medium: 40 vCPU cores, 96 GB

• Large: 40 vCPU cores, 256 GB

The number of cores is twice of that present in equivalent of the Cisco Secure Network Server 3700 series,
due to hyperthreading. For example, in case of Small network deployment, you must allocate 24 vCPU cores
to meet the CPU specification of SNS 3715, which has 12 CPU Cores or 24 Threads.

SNS 3800 Series Appliance:

• Small: 32 vCPU cores, 64 GB

• Medium: 48 vCPU cores, 128 GB

• Large: 48 vCPU cores, 256 GB

The number of cores is twice of that present in equivalent of the Cisco Secure Network Server 3800 series,
due to hyperthreading. For example, in case of Small network deployment, you must allocate 32 vCPU cores
to meet the CPU specification of SNS 3815, which has 16 CPU Cores or 32 Threads.

Note
Reserve vCPU and memory resources equal to the configured vCPU cores and memory allocations. If you do not
do this, Cisco ISE performance and stability can be significantly impacted. Click theCPU andMemory collapsible
areas and update the reservation fields for each setting.

b. From the New SCSI Controller drop-down list, choose Paravirtual.

c. From the New Network and New CD/DVD Drive drop-down lists, choose the required network and ISO files.

Step 10 Choose the NIC driver from the Adapter drop-down list and click Next.
Step 11 Choose Create a new virtual disk and click Next.
Step 12 In the Disk Provisioning dialog box, clickThick provisioned, eagerly zeroed radio button, and clickNext to continue.

Cisco ISE supports both thick and thin provisioning. However, we recommend that you choose thick provisioned,
eagerly zeroed for better performance, especially for Monitoring nodes. If you choose thin provisioning, operations
such as upgrade, backup and restore, and debug logging that require more disk space might be impacted during initial
disk expansion.

Step 13 Clear the check box for Support clustering features such as Fault Tolerance check box.
Step 14 In the Ready to complete area, verify the configuration details, such as name, guest OS, CPUs, memory, and disk size

of the newly created VMware system.
Step 15 Click Finish.
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The VMware system is now installed.

What to do next

To activate the newly created VMware system, right-click VM in the left pane of your VMware client user
interface and choose Power > Power On.

Increase Virtual Machine Power-On Boot Delay Configuration
On a VMware virtual machine, the boot delay is set to 0 by default. You can change the boot delay to make
it easier to choose boot options, such as when resetting the Administrator password.

Procedure

Step 1 From the VSphere client, right click the virtual machine and choose Edit Settings.
Step 2 Click the Options tab.
Step 3 Choose Advanced > Boot Options.
Step 4 From the Power on Boot Delay area, select the time in milliseconds to delay the boot operation.
Step 5 Select the check box in the Force BIOS Setup area to enter into the BIOS setup screen when the VM boots the next

time.
Step 6 Click OK to save your changes.

Install Cisco ISE Software on a VMware System

Before you begin

• After installation, if you do not install a permanent license, Cisco ISE automatically installs a 90-day
evaluation license that supports a maximum of 100 endpoints.

• Download the Cisco ISE software from the Cisco Software Download Site at
http://www.cisco.com/en/US/products/ps11640/index.html . Then, burn the software on a DVD. You
must provide your Cisco.com site credentials.

• (Optional; applicable only if you are installing Cisco ISE on VMware Cloud) The process of installing
Cisco ISE on VMware Cloud is identical to the process for installing Cisco ISE on a VMware virtual
machine.

• Cisco ISE virtual machine deployed on VMware cloud in Amazon Web Services (AWS): Cisco
ISE can be hosted on software-defined data center (SDDC) provided by VMware Cloud on AWS.
Ensure that appropriate security group policies are configured on VMware Cloud (underNetworking
and Security > Security > Gateway Firewall Settings) to enable access to the on-premises
deployment, required devices, and services.

• Cisco ISE virtual machine deployed on Azure VMware Solution (AVS): AVS runs VMware
workloads natively onMicrosoft Azure, where Cisco ISE can be hosted as a VMware virtual machine.
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Procedure

Step 1 Log in to the VMware client.
Step 2 For the VM to enter the BIOS setup mode, right-click the VM and select Edit Settings.
Step 3 Click the Options tab.
Step 4 Click Boot Options, and in the Force BIOS Setup area, check the BIOS check box to enter the BIOS setup screen when

the VM boots.

Note
You must change the firmware from BIOS to EFI in the boot mode of VM settings to boot GPT partitions with 2 TB or
more capacity.

If you have selected Guest OS RHEL 8 and EFI boot mode, disable the Enable UEFI Secure Boot option. This option
is enabled by default for Guest operating system RHEL 8 VM.

Step 5 Click OK.
Step 6 Set the Coordinated Universal Time (UTC) and the correct boot order in BIOS.

a) If the VM is turned on, turn the system off.
b) Turn on the VM.

The system enters BIOS setup mode.

c) In the Main BIOS menu, using the arrow keys, navigate to the Date and Time field and press Enter.
d) Enter the UTC/Greenwich Mean Time (GMT) time zone.

This time zone setting ensures that the reports, logs, and posture-agent log files from the various nodes in your
deployment are always synchronized with regard to the time stamps.

e) Using the arrow keys, navigate to the Boot menu and press Enter.
f) Using the arrow keys, select CD-ROM drive and press + to move the CD-ROM drive up the order.
g) Using the arrow keys, navigate to the Exit menu and choose Exit Saving Changes.
h) Choose Yes to save the changes and exit.

Step 7 Insert the Cisco ISE software DVD into the VMware ESXi host CD/DVD drive and turn on the virtual machine.

When the DVD boots, the console shows:

Automatic installation starts in 150 seconds.
Available boot options:
[1] Cisco ISE Installation (Keyboard/Monitor)
[2] Cisco ISE Installation (Serial Console)
[3] System Utilities (Keyboard/Monitor)
[4] System Utilities (Serial Console)
[5] Hard Disk
Enter boot option and press <Enter>.
boot:

Step 8 Use the arrow keys to select Cisco ISE Installation (Serial Console) or Cisco ISE Installation (Keyboard/Monitor)
and press Enter. If you choose the serial console option, you should have a serial console set up on your virtual machine.
See the VMware vSphere Documentation for information on how to create a console.
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The installer starts the installation of the Cisco ISE software on the VMware system. Allow 20minutes for the installation
process to complete. When the installation process finishes, the virtual machine reboots automatically. When the VM
reboots, the console displays:
Type 'setup' to configure your appliance
localhost:

Step 9 At the system prompt, type setup and press Enter.
The Setup Wizard appears and guides you through the initial configuration.

VMware Tools Installation Verification

Verify VMWare Tools Installation Using the Summary Tab in the vSphere Client

Go to the Summary tab of the specified VMware host in the vSphere Client. Verify that the value in the
VMware Tools field displays "OK".

Figure 7: Verifying VMware Tools in the vSphere Client

Verify VMware Tools Installation Using the CLI

To check if VMware Tools are installed, run the show inventory command. The output displays NIC driver
information. If VMware Tools are installed, you see "VMware Virtual Ethernet driver" in the Driver Description
field.
NAME: "ISE-VM-K9 chassis", DESCR: "ISE-VM-K9 chassis"
PID: ISE-VM-K9 , VID: A0 , SN: FCH184X9XXX
Total RAM Memory: 65700380 kB
CPU Core Count: 16
CPU 0: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 1: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 2: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 3: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 4: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 5: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 6: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 7: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 8: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 9: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 10: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 11: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 12: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 13: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 14: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
CPU 15: Model Info: Intel(R) Xeon(R) CPU E5-2640 v3 @ 2.60GHz
Hard Disk Count(*): 1
Disk 0: Device Name: /xxx/abc
Disk 0: Capacity: 1198.00 GB
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NIC Count: 6
NIC 0: Device Name: eth0:
NIC 0: HW Address: xx:xx:xx:xx:xx:xx
NIC 0: Driver Descr: Intel(R) Gigabit Ethernet Network Driver
NIC 1: Device Name: eth1:
NIC 1: HW Address: xx:xx:xx:xx:xx:xx
NIC 1: Driver Descr: Intel(R) Gigabit Ethernet Network Driver
NIC 2: Device Name: eth2:
NIC 2: HW Address: xx:xx:xx:xx:xx:xx
NIC 2: Driver Descr: Intel(R) Gigabit Ethernet Network Driver
NIC 3: Device Name: eth3:
NIC 3: HW Address: xx:xx:xx:xx:xx:xx
NIC 3: Driver Descr: Intel(R) Gigabit Ethernet Network Driver
NIC 4: Device Name: eth4:
NIC 4: HW Address: xx:xx:xx:xx:xx:xx
NIC 4: Driver Descr: Intel(R) Gigabit Ethernet Network Driver
NIC 5: Device Name: eth5:
NIC 5: HW Address: xx:xx:xx:xx:xx:xx
NIC 5: Driver Descr: Intel(R) Gigabit Ethernet Network Driver

(*) Hard Disk Count may be Logical.

Support for Upgrading VMware Tools

The ISE ISO image contains the supported VMware tools. You cannot upgrade VMware tools using the
VMware client user interface. To use a newer version of VMware tools, upgrade ISE to a newer version.

Clone a Cisco ISE Virtual Machine
You can clone a Cisco ISE VMware virtual machine (VM) to create an exact replica of a Cisco ISE node. For
example, in a distributed deployment with multiple Policy Service nodes (PSNs), VM cloning helps you
deploy the PSNs quickly and effectively. You do not have to install and configure the PSNs individually.

You can also clone a Cisco ISE VM using a template.

For cloning, you need VMware vCenter. Cloning must be done before you run the Setup program. When you
power on the cloned VM for the first time, if VMware prompts you to choose between I Copied It and I
Moved It, you must choose I Copied It. This ensures the VM is assigned a new MAC address and UUID,
resulting in a unique UDI. Choosing I Moved It causes duplicate UDI and registration or licensing issues in
Cisco ISE deployments.

Note

Before you begin

• Shut down the Cisco ISE VM that you plan to clone. In the vSphere client, right-click the Cisco ISE VM
and choose Power > Shut Down Guest.

• Do not change the IP address or hostname before powering on the cloned VM. Complete the cloning
process. Power on the VM and choose I Copied Itwhen prompted. Configure the IP address and hostname
during the initial setup.
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Procedure

Step 1 Log in to the ESXi server as a user with administrative privileges (root user).

VMware vCenter is required to perform this step.

Step 2 Right-click the Cisco ISE VM you want to clone, and click Clone.
Step 3 In the Name and Location dialog box, enter a name for the new machine and click Next.

This is not the hostname of the new Cisco ISE VM that you are creating, but a descriptive name for your reference.

Step 4 Select a host or cluster to run the new Cisco ISE VM, and click Next.
Step 5 Select a datastore for the new Cisco ISE VM and click Next.

The datastore may be the local option on the ESXi server, or remote storage. Ensure the datastore has sufficient disk
space.

Step 6 In the Disk Format dialog box, select the Same format as source radio button, and click Next.

This option copies the format used in the Cisco ISE VM that you are cloning.

Step 7 In the Guest Customization dialog box, select the Do not customize radio button, then click Next.
Step 8 Click Finish.

What to do next

• Changing the IP Address and Hostname of a Cloned Virtual Machine

• Connecting a Cloned Cisco Virtual Machine to the Network

Clone a Cisco ISE Virtual Machine Using a Template
If you use vCenter, you can use a VMware template to clone a Cisco ISE virtual machine (VM). You can
create a template by cloning a Cisco ISE node, then use the template to create multiple Cisco ISE nodes.
Cloning a virtual machine using a template involves two steps.

Before you begin

For cloning, you need VMware vCenter. Cloning must be done before you run the Setup program.Note

Procedure

Step 1 Create a Virtual Machine Template, on page 60
Step 2 Deploy a Virtual Machine Template, on page 60
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Create a Virtual Machine Template

Before you begin

• Ensure that you shut down the Cisco ISE VM that you are going to clone. In the vSphere client, right-click
the Cisco ISE VM that you are about to clone and choose Power > Shut Down Guest.

• We recommend that you create a template from a Cisco ISE VM that you have just installed and not run
the setup program on. You can then run the setup program on each of the individual Cisco ISE nodes
that you have created and configure IP address and hostnames individually.

Procedure

Step 1 Log in to the ESXi server as a user with administrative privileges (root user).

VMware vCenter is required to perform this step.

Step 2 Right-click the Cisco ISE VM that you want to clone and choose Clone > Clone to Template.
Step 3 Enter a name for the template, choose a location to save the template in the Name and Location dialog box, and click

Next.
Step 4 Choose the ESXi host that you want to store the template on and click Next.
Step 5 Choose the datastore that you want to use to store the template and click Next.

Ensure that this datastore has the required amount of disk space.

Step 6 Click the Same format as source radio button in the Disk Format dialog box and click Next.

The Ready to Complete dialog box appears.

Step 7 Click Finish.

Deploy a Virtual Machine Template

After you create a virtual machine template, deploy it on other virtual machines (VMs)

Procedure

Step 1 Right-click the ISE VM template that you have created and choose Deploy Virtual Machine from this template.
Step 2 Enter a name for the new Cisco ISE node. Choose a location for the node in the Name and Location dialog box, and click

Next.
Step 3 Choose either theESXi host where you want to store the new Cisco ISE node and click Next.
Step 4 Choose the datastore that you want to use for the new Cisco ISE node and click Next.

Verify that the datastore has enough disk space.

Step 5 Click the Same format as source radio button in the Disk Format dialog box and click Next.
Step 6 Click the Do not customize radio button in the Guest Customization dialog box.
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The Ready to Complete dialog box is displayed.

Step 7 Check the Edit Virtual Hardware check box and click Continue.

The Virtual Machine Properties page is displayed.

Step 8 Choose Network adapter, uncheck the Connected and Connect at power on check boxes, and click OK.
Step 9 Click Finish.

Power on the Cisco ISE node, configure its IP address and hostname, and connect it to the network.

What to do next

• Changing the IP Address and Hostname of a Cloned Virtual Machine

• Connecting a Cloned Cisco Virtual Machine to the Network

Change the IP address and hostname of a cloned virtual machine
After cloning a Cisco ISE virtual machine (VM), power it on and change its IP address and hostname.

Before you begin

• Make sure your Cisco ISE node is in the standalone state.

• Before you power on the newly cloned Cisco ISE VM, make sure its network adapter is not connected.
Uncheck the Connected and Connect at power on check boxes. This prevents the node from using the
same IP address as the original source machine.

Cloning a Cisco ISE virtual machine will result in the hypervisor assigning a new
MAC address to the primary network interface (eth0). Because Cisco ISE licenses
are tied to the Unique Device Identifier (UDI) generated from this MAC address,
cloning an already-registered node will invalidate its licenses. You must re-host
your licenses in the Cisco Smart Software Manager for the new UDI.

Caution
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Figure 8: Disconnecting the Network Adapter

• Before powering on the newly cloned VM, prepare the IP address and hostname you want to assign. Add
this IP address and hostname in the DNS server. Do not use “localhost” as a hostname.

• Obtain certificates for the Cisco ISE nodes using the new IP address or hostname.

Procedure

Step 1 Right-click the newly cloned Cisco ISE VM and choose Power > Power On.
Step 2 Select the newly cloned Cisco ISE VM and click the Console tab.
Step 3 Enter the following commands on the Cisco ISE CLI:

configure terminal
hostname hostname

Enter the new hostname you want to configure. Cisco ISE services restart after this step.

Step 4 Enter the following commands:
interface gigabit 0
ip address ip_address netmask

Assign an IP address that matches the hostname you entered. Enter the appropriate netmask for this IP address. After you
finish, Cisco ISE prompts you to restart services. For details on the ip address and hostname commands, refer to theCisco
Identity Services Engine CLI Reference Guide.

Step 5 Enter Y to restart Cisco ISE services.
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Connect a Cloned Cisco VM to the Network
After you power on the system and change the IP address and hostname, connect the Cisco ISE node to the
network.

Procedure

Step 1 Right-click the newly cloned Cisco ISE virtual machine (VM) and click Edit Settings.
Step 2 Click Network adapter in the Virtual Machine Properties dialog box.
Step 3 In the Device Status area, check the Connected and Connect at power on check boxes.
Step 4 Click OK.

Migrate Cisco ISE VM from Evaluation to Production
After evaluating the Cisco ISE release, you can migrate the system from an evaluation environment to a fully
licensed production environment.

Before you begin

• When you move the VMware server to a production environment that supports a larger number of users,
be sure to reconfigure the Cisco ISE installation to the recommended minimum disk size or higher (up
to the allowed maximum of 2.4 TB).

• Please note that you cannot migrate data to a production VM from a VM created with less than 300 GB
of disk space. Data can only be migrated from VMs created with 300 GB or more disk space to a
production environment.

Procedure

Step 1 Back up the configuration of the evaluation version.
Step 2 Ensure that your production VM has the required amount of disk space.
Step 3 Install a production deployment license.
Step 4 Restore the configuration to the production system.

Check Virtual Machine Performance On-Demand
You can run the show tech-support command from the CLI to check VM performance at any time. The
output of this command is similar to this example:
ise-vm123/admin# show tech | begin "disk IO perf"
Measuring disk IO performance
*****************************************
Average I/O bandwidth writing to disk device: 48 MB/second
Average I/O bandwidth reading from disk device: 193 MB/second
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WARNING: VM I/O PERFORMANCE TESTS FAILED!
WARNING: The bandwidth writing to disk must be at least 50 MB/second,
WARNING: and bandwidth reading from disk must be at least 300 MB/second.
WARNING: This VM should not be used for production use until disk
WARNING: performance issue is addressed.
Disk I/O bandwidth filesystem test, writing 300 MB to /opt:
314572800 bytes (315 MB) copied, 7.81502 s, 40.3 MB/s
Disk I/O bandwidth filesystem read test, reading 300 MB from /opt:
314572800 bytes (315 MB) copied, 0.416897 s, 755 MB/s

Virtual Machine Resource Check from the Cisco ISE Boot Menu
You can check virtual machine resources from the boot menu without installing Cisco ISE.

The CLI transcript appears in this example:

Cisco ISE Installation (Serial Console)
Cisco ISE Installation (Keyboard/Monitor)
System Utilities (Serial Console)
System Utilities (Keyboard/Monitor)

Use the arrow keys to select System Utilities (Serial Console) or System Utilities (Keyboard/Monitor) and
press Enter. The screen appears:

Available System Utilities:

[1] Recover administrator password
[2] Virtual Machine Resource Check
[3] Perform System Erase
[q] Quit and reload

Enter option [1 - 3] q to Quit

Enter 2 to check for VM resources. The output will resemble this example:
*****
***** Virtual Machine host detected…
***** Hard disk(s) total size detected: 600 Gigabyte
***** Physical RAM size detected: 16267516 Kbytes
***** Number of network interfaces detected: 6
***** Number of CPU cores: 12
***** CPU Mhz: 2300.00
***** Verifying CPU requirement…
***** Verifying RAM requirement…
***** Writing disk partition table…

Linux KVM

KVM Virtualization Check
Your host processor must support KVMvirtualization. For Intel, check for VT-x. For AMD, check for AMD-V.
Open a terminal window on your host and run the cat /proc/cpuinfo command. You should see either the
"vmx" flag or the "svm" flag displayed in the command output.

• For Intel VT-x:
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# cat /proc/cpuinfo
flags: fpu vme de pse tsc msr pae mce cx8 apic sep mtrr pge mca cmov pat pse36 clflush
dts acpi mmx fxsr sse sse2 ss ht tm pbe syscall nx
pdpe1gb rdtscp lm constant_tsc arch_perfmon pebs bts rep_good nopl xtopology nonstop_tsc
aperfmperf eagerfpu pni pclmulqdq dtes64 monitor
ds_cpl vmx smx est tm2 ssse3 cx16 xtpr pdcm pcid dca sse4_1 sse4_2 x2apic popcnt
tsc_deadline_timer aes xsave avx lahf_lm arat epb xsaveopt
pln pts dtherm tpr_shadow vnmi flexpriority ept vpid

• For AMD-V:
# cat /proc/cpuinfo
flags: fpu tsc msr pae mce cx8 apic mtrr mca cmov pat pse36 clflush mmx fxsr sse sse2
ht syscall nx mmxext fxsr_opt rdtscp lm 3dnowext 3dnow
pni cx16 lahf_lm cmp_legacy svm cr8_legacy

Install Cisco ISE on KVM
This procedure explains how to create a KVM on RHEL and install Cisco ISE on it using the Virtual Machine
Manager (virt-manager).

If you choose to install Cisco ISE through the CLI, enter a command similar to this one:

#virt-install --name=kvm-ise1 --arch=x86_64 --cpu=host --vcpus=2 --ram=4096

--os-type=linux --os-variant=rhel6 --hvm --virt-type=kvm
--cdrom=/home/admin/Desktop/ise-3.x.0.x.SPA.x86_64.iso
--disk=/home/libvirt-images/kvm-ise1.img,size=300
--network type=direct,model=virtio,source=eth2,source_mode=bridge

where ise-3.4.0.x.SPA.x86_64.iso is the name of the Cisco ISE ISO image.

Before you begin

Download the Cisco ISE ISO image to your local system.

Procedure

Step 1 From the Virtual Machine Manager window, click File and navigate to New Virtual Machine. In the Create a new
virtual machine dialog box, complete these actions:

a. Click Local install media (ISO media or CDROM) and click Forward.

b. Uncheck the Automatically detect from the installation media/source check box.

c. Choose Red Hat Enterprise Linux 8.2 from the OS drop-down list.

d. Click Browse and choose the disk file system directory from the storage pools navigation pane.

e. Click Browse Local and select the ISO image from your local system and click Open.

f. Click Forward.

g. Choose the Memory and CPU settings and click Forward.

h. Check the Enable storage for the virtual machine check box.
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i. Click Select or create custom storage.

j. Click Manage. In the Choose Storage Volume dialog box, complete these actions:

1. Click + icon next to Volumes.

2. Choose RAW from the Format drop-down list.

3. Enter the Max Capacity as 300 GB.

Note
Use at least 300 GB for production PSN or pxGrid, and at least 600 GB for PAN or MnT personas. For detailed
recommendations, see the table titled Recommended disk space for VMs in this guide.

4. Click Finish.

k. Choose the volume that you created and click Choose Volume.

l. Click Forward.

m. Check the Customize configuration before install check box and click Finish.

The installation screen appears.

Step 2 Click NIC:61:25:78 from the left navigation menu. Under Details tab, perform these actions:

a. Choose Host device eno1:macvtap as the Network source.

b. Choose Bridge as the Source mode.

c. Choose virtio as the Device model.

d. Click Apply.

Step 3 Click Overview from the left navigation menu. Under Details tab, perform these actions:

a. Choose the required firmware from the Firmware drop-down list.

b. Click Apply.

Step 4 Click Begin Installation to install Cisco ISE on KVM.
The Cisco ISE installation boot menu appears.

Step 5 At the system prompt, enter 1 to continue with the installation.
Step 6 At the system prompt, type setup and press Enter.

The Setup Wizard appears and guides you through the initial configuration.

Cisco Identity Services Engine Installation Guide, Release 3.4
66

Additional Installation Information
Install Cisco ISE on KVM



You must add the following text to the VM settings XML file (under vcpu information) while installing Cisco
ISE on Ubuntu Linux KVM. Otherwise, serial number will not be properly displayed in the About ISE and
Server window:
<sysinfo type="smbios">
<system>
<entry name="product">KVM</entry>

</system>
<baseBoard>
<entry name="product">KVM</entry>

</baseBoard>
</sysinfo>
<OS>
<type arch="x86_64" machine="pc-q35-6.2">hvm</type>
<boot dev="hd"/>
<smbios mode="sysinfo"/>

</os>

Note

Microsoft Hyper-V

Create a Cisco ISE virtual machine on Hyper-V
This section explains how to create a new virtual machine, map the ISO image, edit CPU settings, and install
Cisco ISE on Hyper-V.

Cisco ISE does not support Multipath I/O (MPIO). If you use MPIO for the VM, installation will fail.Note

Before you begin

Download the Cisco ISE ISO image from cisco.com to your computer.

Procedure

Step 1 Launch Hyper-V Manager on a supported Windows server.
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Figure 9: Hyper-V Manager Console

Step 2 Right-click the VM host and click New > Virtual Machine.
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Figure 10: Create New Virtual Machine

Step 3 Click Next to customize the VM configuration.
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Figure 11: New Virtual Machine Wizard

Step 4 Enter a name for the VM. Choose a different path to store the VM. Click Next.
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Figure 12: Specify Name and Location

Step 5 Click the Generation 1 radio button and click Next.

If you create a Generation 2 Cisco ISE VM, disable the Secure Boot option in the VM settings.
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Figure 13: Specify Generation

Step 6 Allocate memory to the VM, for example, 16,000 MB. Click Next.
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Figure 14: Assign Memory

Step 7 Select your network adapter and click Next.
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Figure 15: Configure Networking

Step 8 Click the Create a virtual hard disk radio button and click Next.
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Figure 16: Connect Virtual Hard Disk

Step 9 Click the Install an operating system from a bootable CD/DVD-ROM radio button.
a) In the Media area, click the Image file (.iso) radio button.
b) Click Browse to select the ISE ISO image from the local system and click Next.
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Figure 17: Installation Options

Step 10 Click Finish.
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Figure 18: Complete the New Virtual Machine Wizard

You have created the Cisco ISE VM on Hyper-V.
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Figure 19: New Virtual Machine created

Step 11 Select the VM and edit the VM settings.
a) Select Processor. Enter the number of virtual processors (such as 6). Click OK.
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Figure 20: Edit VM Settings

Step 12 Select the VM and click Connect to launch the VM console. Click Start to power on the Cisco ISE VM.
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Figure 21: Start the Cisco ISE VM

The Cisco ISE installation menu appears.
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Figure 22: Cisco ISE installation menu

Step 13 Enter 1 to install Cisco ISE using a keyboard and monitor.
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Zero Touch Provisioning
Use Zero Touch Provisioning (ZTP) to automate Cisco ISE installation, patches, hot patches, and infrastructure
service enablement without manual steps.

ZTP is available starting with Cisco ISE Release 3.1. There are two options available in ZTP:

• Mapping .img file: Use this method for virtual-machine (VM) automatic installations, appliances, and
OVA installations. Configure the required parameters: hostname, IP address, netmask, default gateway,
DNS domain, primary name server, NTP server, system timezone, SSH, username, and password.
Optionally, configure IPv6, patch, hot patch, services, and repository details. See the ZTP Configuration
Image File for more information.

For ZTP on Microsoft Hyper-V, use an .iso file and create a Generation 2 VM.
Do not use an .img file.

Note

• VM User Data: Set mandatory parameters: hostname, IP address, IP netmask, IP default gateway, DNS
domain, primary name server, NTP server, system timezone, SSH, username, and password when using
this method. For more information, see VM User Data.

• Enable the serial console for both the VM and appliance to track installation progress during ZTP.

• Ensure you have a ZTP Configuration Image File.

Note

Provisioning Cisco ISE with ZTP makes these security features available:

• Public Key Authentication

• First Login Password Change

Use TFTP, HTTP, HTTPS, or NFS repositories to install hot patches and patches on Cisco ISE with ZTP.
Repositories created during ZTP are not visible or accessible from the Cisco ISE GUI. You can use only
repositories with anonymous access (no username or password) during ZTP.

Note

Configure Public Key Authentication
Users can be authenticated using public key authentication when you add the public key to the ZTP
configuration file. Enabling public key authentication disables password-based user authentication. You can
disable public key authentication at any time.

To switch back to password-based authentication, use this command in the Cisco ISE CLI:
conf t
no service sshd PubkeyAuthentication
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For more details about this command, refer to the 'Service' section in the chapter 'Cisco ISE CLI Commands
in ConfigurationMode' of theCisco Identity Services Engine CLI Reference Guide for your Cisco ISE release.

Do not execute the command service sshd PubkeyAuthentication unless you have included the public key
in the ZTP configuration image file before installation. This disables password-based authentication, requiring
you to log in using a private key. If you encounter this issue, use the console port to log in to Cisco ISE and
revert the configuration.

Note

Procedure

Step 1 Generate a public and private RSA key pair using a third-party application.
Step 2 Include the public key that is generated in the ZTP configuration image file.
Step 3 Install Cisco ISE using ZTP.
Step 4 Log in to the CLI of Cisco ISE using the private key that is generated, using the following command:

ssh -i <path to private key> <username>@<ise-ip>

You can now successfully log in to the CLI of Cisco ISE using your private key.

First Login Password Change
After successfully installing Cisco ISE using ZTP, you are prompted to reset the password the first time you
log in to the Cisco ISE GUI. The password must be changed because it is specified in plain text in the ZTP
configuration image file. By default, this feature is enabled when you install Cisco ISE using ZTP.

Automatic Installation in Virtual Machine
These subsections provide information about automatic installation in the VM.

These settings are applicable for all on-prem hypervisors:

• VMware

• Linux KVM

• Microsoft Hyper-V

• Nutanix AHV

Automatic Installation in Virtual Machine Using the ZTP Configuration Image File

Procedure

Step 1 Log in to the VMware client.
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Note
If you already have an existing VM setup, proceed to Step 2 and continue to Step 6. For a new VM setup, go directly
to Step 8.

Step 2 To enter BIOS setup mode, right-click the VM and select Edit Settings.
Step 3 Click the Options tab.
Step 4 Click Boot Options.
Step 5 In the Force BIOS Setup area, check the BIOS check box to enter the BIOS setup screen when the VM boots.

Note
Youmust change the firmware fromBIOS toEFI in the VM boot mode settings. This allows you to boot GPT partitions
with 2 TB or greater capacity.

Step 6 Click OK.
Step 7 Ensure that the time zone and the correct boot order are set in BIOS or EFI:

a) If the VM is turned on, turn the system off.
b) Turn on the VM.

The system enters the BIOS setup mode.

c) In the main BIOS menu, use the arrow keys to go to the Date and Time field and press Enter.
d) Enter the time zone.

This time zone setting ensures your reports, logs, and posture-agent log files from all nodes stay synchronized by
timestamp.

e) Using the arrow keys, navigate to the boot menu and press Enter.
f) Using the arrow keys, select the CD-ROM drive and press + to move the CD-ROM drive up the order.
g) Using the arrow keys, navigate to the Exit menu and choose Exit Saving Changes. (Press the Enter or Return key

to select your choice).
h) Choose Yes to save the changes and exit.

Step 8 Insert the Cisco ISE software DVD into the primary CD or DVD drive on the VMware ESXi host.
Step 9 Insert the ZTP configuration image file into a secondary CD or DVD drive.
Step 10 Power on the VM.

When the DVD starts, the console displays this message:

Automatic installation starts in 150 seconds.
Available boot options:
[1] Cisco ISE Installation (Keyboard/Monitor)
[2] Cisco ISE Installation (Serial Console)
[3] System Utilities (Keyboard/Monitor)
[4] System Utilities (Serial Console)
[5] Hard Disk
Enter boot option and press <Enter>.
boot:

Note
From Cisco ISE 3.1 onwards, pressing Enter choosing a boot option triggers ZTP instead of starting installation with
the hard disk.

Step 11 After 150 seconds, the boot process automatically starts if your system meets the prerequisites.
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Note
• Monitor installation logs through the serial console while ZTP is running. When the setup prompt appears, you
can monitor logs from the VM console.

• After the Cisco ISE services are started, you must manually unmount the ZTP configuration image file from the
CD or DVD.

Perform this procedure using ZTP from the setup prompt with the keyboard until the setup prompt appears.

1. Install Cisco ISE manually until setup (using boot option 1 or 2) and use the procedure steps to create the ZTP
configuration image file.

2. Power off the VM and map the ZTP configuration image file to the CD or DVD drive.

3. Power on the VM.

The installation process uses the setup details from the ZTP configuration file you mapped to the CD or DVD drive.

Troubleshooting

Issue: If the automatic installation in the VM is triggered without mapping the .img file, after 150 seconds,
the installation fails with this message.

***** The ZTP configuration image is missing or improper. Automatic installation flow
exited.
***** Power off and attach the proper ZTP configuration image or choose manual boot to
proceed.

Solution: This error message is displayed only on the serial console and not on the VM console. If this happens
in an existing VM where Cisco ISE is already installed, the hard disk will not be formatted in this state. The
existing VM can be recovered by performing these steps:

1. Turning off the VM.

2. Powering on the VM.

3. Press option five to boot from the hard disk within 150 seconds to load the existing VM.

Issue: If the setup details are invalid in the configuration file, ZTP installation is stopped and the following
message is displayed on the VM Console:
==============================================================================

Cisco ISE Installation Failed

==============================================================================

Error: Sync with NTP server failed.

Check the setup details in your configuration image and reboot Cisco ISE

with proper ZTP configuration.

==============================================================================

Solution:

1. Create a new configuration .img file with valid details.

2. Power off the VM.
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3. Map the new valid image to the CD or DVD drive.

4. Power on the VM.

Installation begins from the setup.

Automatic Installation in Virtual Machine using VM User Data

Procedure

Step 1 Log in to the VMware client.

Note
If you already have an existing VM setup, proceed to Step 2 and continue till Step 6. For a new VM setup, go directly
to Step 8.

Step 2 For the VM to enter the BIOS setup mode, right-click the VM and select Edit Settings.
Step 3 Click the Options tab.
Step 4 Click Boot Options.
Step 5 In the Force BIOS Setup area, check the BIOS check box to enter the BIOS setup screen when the VM boots.

Note
You must change the firmware from BIOS to EFI in the the boot mode of VM settings in order to boot GPT partitions
with 2 TB or more capacity.

Step 6 Click OK.
Step 7 Ensure that the time zone and the correct boot order are set in BIOS/EFI:

a) If the VM is turned on, turn the system off.
b) Turn on the VM.

The system enters the BIOS setup mode.

c) In the main BIOS menu, using the arrow keys, navigate to the Date and Time field and press Enter.
d) Enter the time zone.

This time zone setting ensures that the reports, logs, and posture-agent log files from the various nodes in your
deployment are always synchronized with regard to the time stamps.

e) Using the arrow keys, navigate to the boot menu and press Enter.
f) Using the arrow keys, select the CD-ROM drive and press + to move the CD-ROM drive up the order.
g) Using the arrow keys, navigate to the Exit menu and choose Exit Saving Changes (Press the Enter or Return key

to select your choice).
h) Choose Yes to save the changes and exit.

Step 8 Insert the Cisco ISE software DVD into the VMware ESXi host's primary CD/DVD drive.
Step 9 Configure the VM user data options.

Note
If both the .img file and VM user data options are configured in the VM, the user data option is considered.

Step 10 Turn on the VM.
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When the DVD boots, the console displays the following message:

Automatic installation starts in 150 seconds.
Available boot options:
[1] Cisco ISE Installation (Keyboard/Monitor)
[2] Cisco ISE Installation (Serial Console)
[3] System Utilities (Keyboard/Monitor)
[4] System Utilities (Serial Console)
[5] Hard Disk
Enter boot option and press <Enter>.
boot:

Note
From Cisco ISE 3.1 onwards, pressing Enter without entering a boot option does not trigger the installation using the
hard disk option. Instead it triggers ZTP.

Step 11 After 150 seconds, the bootup process automatically starts if the prerequisites are met.

Note
• Installation logs can be monitored only through the serial console because ZTP works only through the serial
console. It can be monitored from the VM console after the setup prompt is displayed.

• After the Cisco ISE services are started, you must manually unmount the ZTP configuration image file from the
CD/DVD.

To leverage ZTP from the setup prompt (ZTP is carried out using the keyboard until the setup prompt apprears) perform
this procedure:

1. Power off the VM.

2. Configure user-data option mentioned above.

3. Power on the VM .

The setup details are picked from the VM options.

Troubleshooting

Issue: If invalid setup details are entered in the user data option, the ZTP installation stops and the following
message is displayed on the VM console:
==============================================================================

Cisco ISE Installation Failed

==============================================================================

Error: Sync with NTP server failed.

Check the setup details in your configuration image and reboot Cisco ISE

with proper ZTP configuration.

==============================================================================

Solution:

1. Power off the VM.
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2. Update user data details with valid data.

3. Power on the VM.

Installation begins from the setup.

Automatic Installation in Appliance
The following subsections provide information about automatic installation in an appliance.

Automatic Installation in Appliance Using the ZTP Configuration Image File

Procedure

Step 1 Log in to the SNS Appliance.
Step 2 Shut down the host system.
Step 3 Choose Compute > Remote Management > Virtual media.
Step 4 Map the Cisco ISE software ISO and the ZTP configuration image file to the primary CD or DVD drive and the secondary

CD or DVD drive.
Step 5 Start the host system.

When the appliance boots, the console displays this message:

Please select boot device:
[1] Cisco ISE Installation (Keyboard/Monitor)
[2] Cisco ISE Installation (Serial Console)
[3] System Utilities (Keyboard/Monitor)
[4] System Utilities (Serial Console)
[5] Cisco ISE Installation Through ZTP Configuration (Serial Console)

Step 6 After 2 minutes and 30 seconds, the process starts automatically if the prerequisites are met.

Note
• ZTP works on the SNS appliance through virtual media only.

• Before mapping the ISO file, ensure the .img file is mapped in virtual media.

Installation logs can be monitored only through the serial console because ZTP works through the serial console.
The logs can be monitored through the KVM console after the setup prompt appears

• Only the .img file supports automatic installation in the appliance.

To use ZTP from the setup prompt (ZTP uses the keyboard until the setup prompt appears), complete these steps:

1. Install Cisco ISE manually till setup (using boot option 1 or 2) and create the ZTP configuration image file using the
steps described in the previous.

2. Shut down the host system and map the ZTP configuration image file that is created, to the CD or DVD drive.

3. Start the host system.
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The setup details are picked from the ZTP configuration file that is mapped to the CD or DVD drive.

Troubleshooting

Issue: If the automatic installation in the appliance is triggered without mapping the image file, after 150
seconds, the installation fails with the this message:

***** The ZTP configuration image is missing or improper. Automatic installation flow
exited.
***** Power off and attach the proper ZTP configuration image or choose manual boot to
proceed.

Solution:

1. Turn off the VM.

2. Turn on the VM.

3. To load the existing VM, press option 5 to boot from the hard disk, within 150 seconds.

Issue: If the setup details are invalid in the config file, ZTP installation is stopped and the following message
is displayed on the Keyboard, video, and mouse (KVM) console:
==============================================================================

Cisco ISE Installation Failed

==============================================================================

Error: Sync with NTP server failed.

Check the setup details in your configuration image and reboot Cisco ISE

with proper ZTP configuration.

==============================================================================

Solution:

1. Create a new configuration .img file with valid details.

2. Power off the VM.

3. Map the new valid image to the CD or DVD drive.

4. Power on the VM.

Installation begins from the setup prompt.

Trigger Automatic Installation using UCS XML APIs
To trigger automatic installation:

The API URL and the request header are the same for all the methods:Note

API URL

https://<ucs_server_ip>/nuova
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Header

headers["Accept"] = "application/xml"
headers["Content-Type"] = "application/xml"

Procedure

Step 1 Obtain the login session cookie to authenticate the session.

The aaaLogin method initiates the login process and is required to begin a session. This method establishes the HTTP or
HTTPS session between the client and Cisco IMC. The session cookie is then used in subsequent requests to maintain
authentication.

Request

<aaaLogin inName='admin' inPassword='password'/>

Response

<aaaLogin cookie="" response="yes" outCookie="<real_cookie>" outRefreshPeriod="600" outPriv="admin"
outSessionId="17" outVersion="3.0(0.149)"> </aaaLogin>

Step 2 Configure the Cisco ISE ISO file as virtual media.

This configures a Cisco ISE ISO file as a virtual media volume.

Request

<configConfMo cookie='<real_cookie>' dn='sys/svc-ext/vmedia-svc/vmmap-ISE_ISO' inHierarchical='false'>
<inConfig>
<commVMediaMap dn='sys/svc-ext/vmedia-svc/vmmap-ISE_ISO'
map=’nfs’
remoteFile=‘<ise_iso_file>’
remoteShare=‘<nfs_server_path>'
status='created' volumeName='ISE_ISO' />
</inConfig>
</configConfMo>

Response

<configConfMo dn="sys/svc-ext/vmedia-svc/vmmap-ISE_ISO"
cookie="<real_cookie>" response="yes">
<outConfig>
<commVMediaMap volumeName="ISE_ISO" map=“nfs”
remoteShare=‘<nfs_server_path>'
remoteFile="<ise_iso_file>"
mappingStatus="In Progress"
dn="sys/svc-ext/vmedia-svc/vmmap-ISE_ISO" status="created"/>
</outConfig>

</configConfMo>

Step 3 Configure the configuration image file as a virtual media volume.

This configures a configuration image as a vMedia volume.

Request

<configConfMo cookie='<real_cookie>'
dn='sys/svc-ext/vmedia-svc/vmmap-CONFIG-IMG’ inHierarchical='false'>
<inConfig>
<commVMediaMap dn='sys/svc-ext/vmedia-svc/vmmap-CONFIG-IMG'
map=’nfs’
remoteFile=‘<config_img_file>’
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remoteShare=‘<nfs_server_path>'
status='created' volumeName='CONFIG-IMG' />

</inConfig>
</configConfMo>

Response

<configConfMo dn="sys/svc-ext/vmedia-svc/vmmap-CONFIG-IMG"
cookie="<real_cookie>" response="yes">
<outConfig>
<commVMediaMap volumeName="CONFIG-IMG" map=“nfs”
remoteShare=‘<nfs_server_path>'
remoteFile="<config_img_file>"
mappingStatus="In Progress"
dn="sys/svc-ext/vmedia-svc/vmmap-CONFIG-IMG" status="created"/>
</outConfig>

</configConfMo>

Step 4 Set the CD-ROM as the first device in the boot order.

This maps the Cisco ISE ISO file that is picked for installation during the power restart.

Request

<configConfMo cookie="<real_cookie>"
inHierarchical="true" dn="sys/rack-unit-1/boot-policy">
<inConfig>
<lsbootDef dn="sys/rack-unit-1/boot-policy" rebootOnUpdate=“yes”>
<lsbootVirtualMedia access="read-only" order=“1” dn="sys/rack-unit-1/boot-policy/vm-read-only"/>

</lsbootDef>
</inConfig>

</configConfMo>

Response

<configConfMo dn="sys/rack-unit-1/boot-policy" cookie="<real_cookie>" response="yes">
<outConfig>
<lsbootDef dn="sys/rack-unit-1/boot-policy" name="boot-policy" purpose="operational"

rebootOnUpdate="no" status="modified" >
</lsbootDef>

</outConfig>
</configConfMo>

Step 5 Enable the SoL (Serial over LAN).

This enables the SoL to view installation logs through Telnet.

Request

<configConfMo cookie='<real_cookie>'
dn='sys/rack-unit-1/sol-if'>
<inConfig>
<solIf dn='sys/rack-unit-1/sol-if' adminState=‘enable'/>
</inConfig>
</configConfMo>

Response

<configConfMo dn="sys/rack-unit-1/sol-if" cookie="<real_cookie>" response="yes">
<outConfig>
<solIf dn="sys/rack-unit-1/sol-if" adminState="enable" name="SoLInterface" speed="115200" comport="com0"
sshPort="2400" status="modified" ></solIf></outConfig>
</configConfMo>

Step 6 Power restart.
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This triggers Cisco ISE installation in automatic mode.

Request

<configConfMo cookie='<real_cookie>' dn='sys/rack-unit-1'>
<inConfig><computeRackUnit
dn='sys/rack-unit-1'
adminPower='cycle-immediate'/>
</inConfig>
</configConfMo>

Response

<configConfMo dn="sys/rack-unit-1" cookie="<real_cookie>" response="yes">
<outConfig>

<computeRackUnit dn="sys/rack-unit-1" adminPower="policy" availableMemory="262144"
model="SNS-3695-K9" memorySpeed="2400" name="SNS-3695-K9" numOfAdaptors="0" numOfCores="12"
numOfCoresEnabled="12" numOfCpus="1" numOfEthHostIfs="0" numOfFcHostIfs="0" numOfThreads="24"
operPower="on" originalUuid="1935836B-B968-4031-8A98-7984F1D35449" presence="equipped" serverId="1"
serial="WZP2228085W" totalMemory="262144" usrLbl="" uuid="1935836B-B968-4031-8A98-7984F1D35449"
vendor="Cisco Systems Inc" cimcResetReason="graceful-reboot
" assetTag="Unknown" adaptorSecureUpdate="Enabled" resetComponents="components" storageResetStatus="NA"
vicResetStatus="NA" bmcResetStatus="NA" smartUsbAccess="disabled" smartUsbStatus="Disabled"
biosPostState="completed" status="modified" >
</computeRackUnit>

</outConfig>
</configConfMo>

Step 7 Log out to end the session.

Request

<aaaLogout
cookie="<real_cookie>"
inCookie="<real_cookie>"

</aaaLogout>

Response:

<aaaLogout cookie="" response="yes" outStatus="success"> </aaaLogout>

For more information, see UCS API methods.

OVA Automatic Installation
Use these sections to automatically install the OVA.

Automatic OVA Installation Using the ZTP Configuration Image File

Procedure

Step 1 Log in to the VMware client.

Note
If you already have an existing virtual machine setup, complete Steps 2 through 6. For a new virtual machine setup,
start with Step 8.
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Step 2 To enter BIOS setup mode, right-click the virtual machine and select Edit Settings.
Step 3 Click the Options tab.
Step 4 Click Boot Options.
Step 5 In the Force BIOS Setup area, check the BIOS check box to enter the BIOS setup screen when the VM boots.

Note
Change the firmware from BIOS to EFIin the VM’s boot mode to enable GPT partitions of 2 TB or more.

Step 6 Click OK.
Step 7 Ensure that the Coordinated Universal Time (UTC) is set and the boot order is correct in BIOS.

a) If the virtual machine is turned on, turn the system off.
b) Turn on the VM.

The system enters the BIOS setup mode.

c) In the main BIOS menu, using the arrow keys, navigate to the Date and Time field and press Enter.
d) Enter the UTC or Greenwich Mean Time (GMT) time zone.

This time zone setting keeps reports, logs, and posture-agent log files from all nodes in your deployment synchronized
for timestamps.

e) Use the arrow keys to open the boot menu and press Enter.
f) Using the arrow keys, select the CD-ROM drive and press + to move the CD-ROM drive up the order.
g) Using the arrow keys, navigate to the Exit menu and choose Exit Saving Changes (Press the Enter or Return key

to select your choice).
h) Choose Yes to save the changes and exit.

Step 8 Import the Cisco ISE OVA file into your VMware ESXi host.
Step 9 Insert the ZTP configuration image file into the primary CD drive or DVD drive of your VMware ESXi host.
Step 10 Turn on your virtual machine.

When the DVD boots, the console displays a message:

Automatic installation starts in 150 seconds.
Available boot options:
[1] Cisco ISE Installation (Keyboard/Monitor)
[2] Cisco ISE Installation (Serial Console)
[3] System Utilities (Keyboard/Monitor)
[4] System Utilities (Serial Console)
[5] Hard Disk
Enter boot option and press <Enter>.
boot:

Note
If you pressEnterwithout selecting a boot option in Cisco ISE 3.1 or later, the system initiates ZTP instead of installing
using the hard disk option.

Step 11 After 150 seconds, the bootup process automatically starts if the prerequisites are met.

Note
• Monitor the installation logs through the serial console while ZTP runs. After the setup prompt appears, view the
logs in your virtual machine console.

• After the Cisco ISE services are started, you must manually unmount the ZTP configuration image file from the
CD or DVD.
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Use the keyboard to perform ZTP until the setup prompt appears. Then, follow this procedure:

a. Install Cisco ISE manually using boot option 1 or 2, and create the ZTP configuration image file using the steps in
this procedure.

b. Power off the virtual machine.

c. Map the ZTP configuration image file to the CD or DVD drive.

d. Power on the virtual machine.

The system uses the setup details from the ZTP configuration file that mapped to the CD or DVD drive.

Troubleshooting

Issue: If the setup details are invalid in the configuration file, ZTP installation stops and the following message
is displayed on the VM console:
==============================================================================

Cisco ISE Installation Failed

==============================================================================

Error: Sync with NTP server failed.

Check the setup details in your configuration image and reboot Cisco ISE

with proper ZTP configuration.

==============================================================================

Solution: This can be resolved by performing the following steps:

1. Create a new configuration .img file with valid details.

2. Power off the VM.

3. Map the new valid image to the CD or DVD drive.

4. Power on the VM.

OVA Automatic Installation Using the VM User Data

Procedure

Step 1 Log in to the VMware client.

Note
If you already set up a VM, start at Step 2 and continue to Step 6. If you are setting up a new VM, start at Step 8.

Step 2 Right-click the VM and select Edit Settings to enter the BIOS setup mode.
Step 3 Click the Options tab.
Step 4 Click Boot Options.
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Step 5 In the Force BIOS Setup area, check the BIOS check box to enter the BIOS setup screen when the VM boots.

Note
Change the firmware from BIOS to EFIin the VM’s boot mode settings so you can boot GPT partitions larger than 2
TB.

Step 6 Click OK.
Step 7 Ensure that the Coordinated Universal Time (UTC) and the correct boot order are set in BIOS:

a) If the VM is turned on, turn the system off.
b) Power off the VM.

You see the BIOS setup mode.

c) In the main BIOS menu, using the arrow keys, navigate to the Date and Time field and press Enter.
d) Enter the Coordinated Universal Time (UTC) or Greenwich Mean Time (GMT) zone.

With this time zone setting, the reports, logs, and posture-agent log files from the nodes in your deployment always
have synchronized timestamps.

e) Using the arrow keys, navigate to the boot menu and press Enter.
f) Select the compact disc read-only memory (CD-ROM) drive using the arrow keys and press+ to move the CD-ROM

drive up the order.
g) Using the arrow keys, navigate to the Exit menu and choose Exit Saving Changes (Press the Enter or Return key

to select your choice).
h) Choose Yes to save the changes and exit.

Step 8 Import the Cisco ISE OVA file into the VMware ESXi.
Step 9 Configure the VM user data options.

Note
The VM uses the user data option if both the image file and the VM user data options are configured.

Step 10 Turn on the VM.

When the DVD boots, the console displays the following message:

Automatic installation starts in 150 seconds.
Available boot options:
[1] Cisco ISE Installation (Keyboard/Monitor)
[2] Cisco ISE Installation (Serial Console)
[3] System Utilities (Keyboard/Monitor)
[4] System Utilities (Serial Console)
[5] Hard Disk
Enter boot option and press <Enter>.
boot:

Note
From Cisco ISE 3.1 onwards, pressing Enter without entering a boot option does not trigger the installation using the
hard disk option. Instead, it triggers ZTP.

Step 11 If the prerequisites are met, the bootup process starts automatically after 150 seconds.

Note
• To monitor installation logs, use the serial console. ZTP interacts only through the serial console. Monitoring from
the VM console is possible after the setup prompt is displayed.
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• After Cisco ISE services have started, manually unmount the ZTP configuration image file from the CD or DVD.

To use ZTP from the setup prompt, perform this procedure. ZTP is carried out using the keyboard until the setup prompt
appears.

a. Power off the VM.

b. Configure user-data option mentioned above.

c. Power on the VM .

The VM options provide the setup details.

Troubleshooting information

Issue: If invalid setup details are entered in the user data option, the ZTP installation stops and this message
is displayed on the VM console:
==============================================================================

Cisco ISE Installation Failed

==============================================================================

Error: Sync with NTP server failed.

Check the setup details in your configuration image and reboot Cisco ISE

with proper ZTP configuration.

==============================================================================

Solution:To resolve this issue, complete the following steps.

1. Power off the VM.

2. Update user data details with valid data.

3. Power on the VM.

Installation begins from the setup.

Create a ZTP Configuration Image File
Create the ZTP configuration image file using the ./create_ztp_image.sh ise-ztp.conf ise-ztp.img command.
The script can be executed on Red Hat Enterprise Linux (RHEL), CentOS, or Ubuntu.

To skip the ICMP, DNS, and NTP checks, set the flags to True in the configuration image file:

• ICMP: SkipIcmpChecks=true

• DNS: SkipDnsChecks=true

• NTP: SkipNtpChecks=true
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The default value for each flag is false. By default, during the ZTP installation performs these checks if the
flags are not explicitly mentioned in the configuration file.

Note

create_ztp_image.sh script creation

#!/bin/bash
###########################################################
# This script is used to generate ise ztp image with ztp
# configuration file.
#
# Need to pass ztp configuration file as input.
#
# Copyright (c) 2021 by Cisco Systems, Inc.
# All rights reserved.
# Note:
# To mount the image use below command
# mount ise_ztp_config.img /ztp
# To mount the image from cdrom
# mount -o ro /dev/sr1 /ztp
#############################################################
if [ -z "$1" ];then
echo "Usage:$0 <ise-ztp.conf> [out-ztp.img]"
exit 1
elif [ ! -f $1 ];then
echo "file $1 not exist"
exit 1
else
conf_file=$1
fi
if [ -z "$2" ] ;then
image=ise_config.img
else
image=$2
fi
mountpath=/tmp/ise_ztp
ztplabel=ISE-ZTP
rm -fr $mountpath
mkdir -p $mountpath
dd if=/dev/zero of=$image bs=1k count=1440 > /dev/null 2>&1
if [ `echo $?` -ne 0 ];then
echo "Image creation failed\n"
exit 1
fi
mkfs.ext4 $image -L $ztplabel -F > /dev/null 2>&1
mount -o rw,loop $image $mountpath
cp $conf_file $mountpath/ise-ztp.conf
sync
umount $mountpath
sleep 1
# Check for automount and unmount
automountpath=$(mount | grep $ztplabel | awk '{print $3}')
if [ -n "$automountpath" ];then
umount $automountpath
fi
echo "Image created $image"
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VM User Data
You can use VM user data with Cisco ISE installation on ESXi version 6.5 and later.

Paste the contents that are in the ise-ztp.conf file into the Base64 encode tool. Use the base64encode tool to
obtain the encoded string.

Enter the encoded Base64 string in the VM with the VM user data. In VMware ESXi, go to VM Options >
Advanced > Configuration Parameters > Edit Configuration > guestinfo.ise.ztp = [Value] Base Encoded
ZTP Configuration with the Base Encoded ZTP Configuration string.

When configuring ZTP to deploy a patch or hot patch, you must use http (lowercase) instead of HTTP.
Otherwise, the patch files cannot be downloaded from the repository.

Note
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C H A P T E R 5
Installation Verification and Post-Installation
Tasks

• Log in to the Cisco ISE web-based interface, on page 99
• Cisco ISE configuration verification, on page 101
• List of post-installation tasks, on page 103

Log in to the Cisco ISE web-based interface
When you log in to the Cisco ISE web-based interface for the first time, you use the preinstalled Evaluation
license.

Procedure

Step 1 After the Cisco ISE appliance finishes rebooting, launch one of the supported web browsers.

For information about validated browsers, refer to the “Validated Browsers” section in the Cisco ISE Release Notes.

Step 2 In the Address field, enter the IP address or hostname of the Cisco ISE appliance in this format, then press Enter.
https://<IP address or host name>/admin/

Step 3 Enter your username and password.
Step 4 Click Login.

• For security, log out when you complete your administrative session. If you do not log out, Cisco ISE
logs you out after 30 minutes of inactivity and does not save any unsubmitted configuration data.

• If Cisco ISE is installed in the cloud or using the ZTP process, you will be prompted to change the
web-based admin user password during the first login.

Note
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Differences between CLI admin and web-based admin user tasks
Use the username and password you set during Cisco ISE setup for administrative access to the CLI and the
web interface.

The administrator with access to the Cisco ISE CLI is called the CLI-admin user. By default, the CLI-admin
username is admin. The administrator must create the password during the setup process, as Cisco ISE does
not provide a default password.

You can initially access the Cisco ISE web interface by using the CLI-admin username and password that
you defined during setup. A web-based admin user does not have a default username or password.

Cisco ISE copies the CLI-admin user to the web-based admin user database. Only the first CLI-admin user
is copied as the web-based admin user. Ensure that the CLI and web-based administrator user stores remain
synchronized. Using the same username and password for both roles simplifies administration.

The CLI-admin user has different rights and capabilities than the web-based admin user and can perform
additional administrative tasks.

Table 15: Tasks performed by CLI-admin and web-based admin users

TasksAdmin user type

• Back up Cisco ISE application data

• Display any system, application, or diagnostic logs on the Cisco ISE
appliance

• Apply Cisco ISE software patches, maintenance releases, and upgrades

• Set the NTP server configuration

Both CLI-admin and web-based
admin

• Start and stop Cisco ISE application software

• Reload or shut down the Cisco ISE appliance

• Reset the web-based admin user in case of a lockout

• Access Cisco ISE CLI

CLI-admin only

Create a CLI admin
You can create additional CLI-admin user accounts after you complete the setup process. To keep your account
secure, create only the number of CLI-admin users you need for Cisco ISE CLI access. This method helps
you protect your credentials.

You can add a CLI-admin user with this command in configuration mode:
username <username> password [plain/hash] <password> role admin

Create a web-based admin
To access Cisco ISE through the web interface initially, use the administrator username and password configured
during CLI setup.
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To add an administrator user, perform these steps:

1. In the Cisco ISE GUI, click the Menu icon ( ) and choose Administration > System > Admin Access
> Administrators > Admin Users.

2. Choose Add > Create an Admin User.

3. Add web-based administrator users using the user interface.

4. Click Submit.

Reset a disabled password due to administrator lockout
If you enter an incorrect password five times, your account becomes disabled.

Use these instructions to reset the administrator user interface password with the application reset-passwd
ise command in the Cisco ISE CLI. Resetting the administrator password activates new credentials immediately
and allows you to log in without rebooting the system. This process does not affect the administrator's CLI
password.

Cisco ISE adds a log entry in the Administrator Logins window. To view this window, click the Menu icon
( ) and chooseOperations >Reports >Reports >Audit >Administrator Logins. Reset your administrator
ID password to regain access to your credentials.

Procedure

Step 1 Access the direct-console CLI and enter:

application reset-passwd ise administrator_ID

Step 2 Specify and confirm a new password that is different from the passwords that were usedmost recently for this administrator
ID.

Enter new password:
Confirm new password:

Password reset successfully

Cisco ISE configuration verification
You can verify the Cisco ISE configuration using a web browser or the CLI. Each method requires a different
set of username and password credentials.

The CLI administrator user credentials and the web-based administrator user credentials are different in Cisco
ISE.

Note
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Verify configuration using a web browser
Follow these steps to verify the configuration using a web browser:

Procedure

Step 1 After the Cisco ISE appliance reboots, open a supported web browser.
Step 2 In the Address field, enter the IP address or host name of the Cisco ISE appliance using this format, and press Enter.
Step 3 On the Cisco ISE Login page, enter the username and password you created during setup. Click Login.

For example, enter https://192.0.2.10/admin/. The Cisco ISE Login page appears.

https://<IP address or host name>/admin/

Note
For first-time access to the Cisco ISE system using a web browser, the administrator username and password are the same
as the credentials you configured for command-line interface access during setup.

Step 4 Use the Cisco ISE dashboard to verify that the appliance is working correctly.

What to do next

Use the Cisco ISE web-based interface menus and options to configure the system to suit your needs. For
details on configuring Cisco ISE,refer to Cisco Identity Services Engine Administrator Guide.

Verify configuration using the CLI
Follow these steps to verify the configuration using the CLI:

Before you begin

Download and install the latest Cisco ISE patch to keep Cisco ISE appliance up to date.

Procedure

Step 1 After your Cisco ISE appliance reboots, open a supported application, such as PuTTY, to connect to your Cisco ISE
appliance using Secure Shell (SSH).

Step 2 In the Host Name or IP Address field, enter the hostname or IP address (in dotted decimal format) for your Cisco ISE
appliance, and click Open.

Step 3 At the login prompt, enter the CLI-admin username you created during setup. The default user name is admin. Press
Enter.

Step 4 At the password prompt, enter the CLI-admin password you created during setup. Press Enter.
Step 5 At the system prompt, enter show application version ise and press Enter.
Step 6 To check the status of the Cisco ISE processes, enter show application status ise and press Enter.

The console output appears as shown:
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ise-server/admin# show application status ise

ISE PROCESS NAME STATE PROCESS ID
--------------------------------------------------------------------
Database Listener running 4930
Database Server running 66 PROCESSES
Application Server running 8231
Profiler Database running 6022
ISE Indexing Engine running 8634
AD Connector running 9485
M&T Session Database running 3059
M&T Log Collector running 9271
M&T Log Processor running 9129
Certificate Authority Service running 8968
EST Service running 18887
SXP Engine Service disabled
TC-NAC Docker Service disabled
TC-NAC MongoDB Container disabled
TC-NAC RabbitMQ Container disabled
TC-NAC Core Engine Container disabled
VA Database disabled
VA Service disabled
pxGrid Infrastructure Service disabled
pxGrid Publisher Subscriber Service disabled
pxGrid Connection Manager disabled
pxGrid Controller disabled
PassiveID Service disabled
DHCP Server (dhcpd) disabled
DNS Server (named) disabled

List of post-installation tasks
After you install Cisco ISE, you must perform these mandatory tasks:

Table 16: Mandatory post-installation tasks

Link in the Administration GuideTask

Refer to the "Software Patch Installation Guidelines"
in the "Maintain and Monitor" chapter of the Cisco
ISE Administrator Guide for your release.

Apply the latest patches, if any

Refer to the Cisco ISE Licensing Guide for more
information. See the chapter "Licensing" in theCisco
ISE Administrator Guide for your release.

Install licenses

Refer to the section "CertificateManagement in Cisco
ISE" in the chapter "Basic Setup" in the Cisco ISE
Administrator Guide for your release.

Install certificates

Refer to "Create Repositories" in the "Maintain and
Monitor" chapter of the Cisco ISE Administrator
Guide for your release

Create repository for backups
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Link in the Administration GuideTask

Refer to "Schedule a Backup" in the "Maintain and
Monitor" chapter of the Cisco ISE Administrator
Guide for your release.

Configure backup schedules

Refer to the section "Cisco ISE Distributed
Deployment" in the chapter "Deployment" in the
Cisco ISE Administrator Guide for your release.

Deploy Cisco ISE personas
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C H A P T E R 6
Common System Maintenance Tasks

• Bond ethernet interfaces for high availability, on page 105
• Reset a lost, forgotten, or compromised password using a DVD, on page 110
• Reset a disabled password due to administrator lockout, on page 111
• Change the IP address of a Cisco ISE appliance, on page 111
• View installation and upgrade history, on page 112
• Perform a system erase, on page 113

Bond ethernet interfaces for high availability
Cisco ISE supports bonding two ethernet interfaces into a single virtual interface, providing high availability
for the physical interfaces. This feature is called Network Interface Card (NIC) bonding or NIC teaming.
When two interfaces are bonded, they appear as a single device with one MAC address.

You can use NIC bonding in Cisco ISE only for high availability. It does not support load balancing or link
aggregation.

Bonding interfaces ensures that the Cisco ISE services are not affected by:

• Physical interface failure

• Loss of switch port connectivity due to shutdown or failure

• Switch line card failure

When two interfaces are bonded, one becomes the primary interface and the other becomes the backup interface.
All traffic flows through the primary interface. If the primary interface fails, the backup interface then routes
all traffic. The bond uses the IP address and MAC address of the primary interface.

When you configure the NIC bonding feature, Cisco ISE pairs fixed physical NICs into bonded NICs. The
table lists the NIC pairs that can form a bonded interface.

Table 17: Physical NICs bonded together to form an interface

Bonded NIC nameRole in bonded NICLinux physical NIC nameCisco ISE physical NIC
name

bond 0PrimaryEth0Gigabit Ethernet 0

BackupEth1Gigabit Ethernet 1
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Bonded NIC nameRole in bonded NICLinux physical NIC nameCisco ISE physical NIC
name

bond 1PrimaryEth2Gigabit Ethernet 2

BackupEth3Gigabit Ethernet 3

bond 2PrimaryEth4Gigabit Ethernet 4

BackupEth5Gigabit Ethernet 5

Supported platforms
You can use the NIC bonding feature on all supported platforms and node personas. The supported platforms
are:

• SNS hardware appliances—bond 0, 1, and 2.

• You can configure bond 0, 1, and 2 on virtual machines if six NICs are available.

Guidelines for bonding ethernet interfaces
• As Cisco ISE supports up to six Ethernet interfaces, it can have only three bonds, bond 0, bond 1, and
bond 2.

• You cannot change the interfaces that are part of a bond or change the role of the interface in a bond.
See the above table for information on which NICs can be bonded together and their role in the bond.

• The Eth0 interface acts as both the management interface as well as the runtime interface. The other
interfaces act as runtime interfaces.

• Before you create a bond, the primary interface (primary NIC) must be assigned an IP address. The Eth0
interface must be assigned an IPv4 address before you create bond 0. Similarly, before you create bond
1 and 2, Eth2 and Eth4 interfaces must be assigned an IPv4 or IPv6 address, respectively.

• Before you create a bond, if the backup interface (Eth1, Eth3, and Eth5 ) has an IP address assigned,
remove the IP address from the backup interface. The backup interface should not be assigned an IP
address.

• You can choose to create only one bond (bond 0) and allow the rest of the interfaces to remain as is. In
this case, bond 0 acts as the management interface and runtime interface, and the rest of the interfaces
act as runtime interfaces.

• You can change the IP address of the primary interface in a bond. The new IP address is assigned to the
bonded interface because it assumes the IP address of the primary interface.

• When you remove the bond between two interfaces, the IP address assigned to the bonded interface is
assigned back to the primary interface.

• If you want to configure the NIC bonding feature on a Cisco ISE node that is part of a deployment, you
must deregister the node from the deployment, configure NIC bonding, and then register the node back
to the deployment.
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• If a physical interface that acts as a primary interface in a bond (Eth0, Eth2, or Eth4 interface) has static
route configured, the static routes are automatically updated to operate on the bonded interface instead
of the physical interface.

Configure NIC bonding
You can configure NIC bonding from the Cisco ISE CLI for bond 0 between Eth0 and Eth1 interfaces.

Before you begin

If a physical interface, such as Eth1, Eth3, or Eth5, serves as a backup and is configured with an IP address,
remove the IP address from that interface. Leave the backup interface without an IP address.

Procedure

Step 1 Log in to Cisco ISE CLI with your administrator account.
Step 2 Enter configure terminal to enter the configuration mode.
Step 3 Enter the interface GigabitEthernet 0 command.
Step 4 Enter the backup interface GigabitEthernet 1 command.

The console displays:

% Warning: IP address of interface eth1 will be removed once NIC bonding is enabled. Are you sure
you want to proceed? Y/N [N]:

Step 5 Enter Y and press Enter.

After you configure bond 0, Cisco ISE restarts automatically.Wait until all services are running. Enter the show application
status ise command from the CLI to check whether all services are running.

ise/admin# configure terminal
Enter configuration commands, one per line. End with CNTL/Z.
ise/admin(config)# interface gigabitEthernet 0
ise/admin(config-GigabitEthernet)# backup interface gigabitEthernet 1
Changing backup interface configuration may cause ISE services to restart.
Are you sure you want to proceed? Y/N [N]: Y
Stopping ISE Monitoring & Troubleshooting Log Collector...
Stopping ISE Monitoring & Troubleshooting Log Processor...
ISE PassiveID Service is disabled
ISE pxGrid processes are disabled
Stopping ISE Application Server...
Stopping ISE Certificate Authority Service...
Stopping ISE EST Service...
ISE Sxp Engine Service is disabled
Stopping ISE Profiler Database...
Stopping ISE Indexing Engine...
Stopping ISE Monitoring & Troubleshooting Session Database...
Stopping ISE AD Connector...
Stopping ISE Database processes...
Starting ISE Monitoring & Troubleshooting Session Database...
Starting ISE Profiler Database...
Starting ISE Application Server...
Starting ISE Indexing Engine...
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Starting ISE Certificate Authority Service...
Starting ISE EST Service...
Starting ISE Monitoring & Troubleshooting Log Processor...
Starting ISE Monitoring & Troubleshooting Log Collector...
Starting ISE AD Connector...
Note: ISE Processes are initializing. Use 'show application status ise'

CLI to verify all processes are in running state.
ise/admin(config-GigabitEthernet)#

Verify NIC bonding configuration
To verify if NIC bonding feature is configured, run the show running-config command from the Cisco ISE
CLI. You will see an output similar to this example:

!
interface GigabitEthernet 0
ipv6 address autoconfig
ipv6 enable
backup interface GigabitEthernet 1
ip address 192.168.118.214 255.255.255.0

!

In the output, the entry "backup interface GigabitEthernet 1" indicates that NIC bonding is configured on
Gigabit Ethernet 0. Gigabit Ethernet 0 is the primary interface, and Gigabit Ethernet 1 is the backup interface.
The ADE-OS configuration does not display an IP address for the backup interface in the running configuration.
The same IP address is used for both the primary and backup interfaces.

You can also run the show interface command to see the bonded interfaces.

ise/admin# show interface
bond0: flags=5187<UP,BROADCAST,RUNNING,PRIMARY,MULTICAST> mtu 1500

inet 10.126.107.60 netmask 255.255.255.0 broadcast 10.126.107.255
inet6 fe80::8a5a:92ff:fe88:4aea prefixlen 64 scopeid 0x20<link>
ether 88:5a:92:88:4a:ea txqueuelen 0 (Ethernet)
RX packets 1726027 bytes 307336369 (293.0 MiB)
RX errors 0 dropped 844 overruns 0 frame 0
TX packets 1295620 bytes 1073397536 (1023.6 MiB)
TX errors 0 dropped 0 overruns 0 carrier 0 collisions 0

GigabitEthernet 0
flags=6211<UP,BROADCAST,RUNNING,SUBORDINATE,MULTICAST> mtu 1500
ether 88:5a:92:88:4a:ea txqueuelen 1000 (Ethernet)
RX packets 1726027 bytes 307336369 (293.0 MiB)
RX errors 0 dropped 844 overruns 0 frame 0
TX packets 1295620 bytes 1073397536 (1023.6 MiB)
TX errors 0 dropped 0 overruns 0 carrier 0 collisions 0
device memory 0xfab00000-fabfffff

GigabitEthernet 1
flags=6211<UP,BROADCAST,RUNNING,SUBORDINATE,MULTICAST> mtu 1500
ether 88:5a:92:88:4a:ea txqueuelen 1000 (Ethernet)
RX packets 0 bytes 0 (0.0 B)
RX errors 0 dropped 0 overruns 0 frame 0
TX packets 0 bytes 0 (0.0 B)
TX errors 0 dropped 0 overruns 0 carrier 0 collisions 0
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device memory 0xfaa00000-faafffff

Remove NIC bonding
Use the no form of the backup interface command to remove a NIC bond.

Before you begin

Procedure

Step 1 Log in to Cisco ISE CLI with your administrator account.
Step 2 Enter configure terminal to enter the configuration mode.
Step 3 Enter the interface GigabitEthernet 0 command.
Step 4 Enter the no backup interface GigabitEthernet 1 command.

% Notice: Bonded Interface bond 0 has been removed.

Step 5 Enter Y and press Enter.

Bond 0 is now removed. Cisco ISE restarts automatically. Wait until all services are running successfully. Enter the show
application status ise command from the CLI to verify that all the services are running.

ise/admin# configure terminal
Enter configuration commands, one per line. End with CNTL/Z.
ise/admin(config)# interface gigabitEthernet 0
ise/admin(config-GigabitEthernet)# no backup interface gigabitEthernet 1

Changing backup interface configuration may cause ISE services to restart.
Are you sure you want to proceed? Y/N [N]: Y
Stopping ISE Monitoring & Troubleshooting Log Collector...
Stopping ISE Monitoring & Troubleshooting Log Processor...
ISE PassiveID Service is disabled
ISE pxGrid processes are disabled
Stopping ISE Application Server...
Stopping ISE Certificate Authority Service...
Stopping ISE EST Service...
ISE Sxp Engine Service is disabled
Stopping ISE Profiler Database...
Stopping ISE Indexing Engine...
Stopping ISE Monitoring & Troubleshooting Session Database...
Stopping ISE AD Connector...
Stopping ISE Database processes...
Starting ISE Monitoring & Troubleshooting Session Database...
Starting ISE Profiler Database...
Starting ISE Application Server...
Starting ISE Indexing Engine...
Starting ISE Certificate Authority Service...
Starting ISE EST Service...
Starting ISE Monitoring & Troubleshooting Log Processor...
Starting ISE Monitoring & Troubleshooting Log Collector...
Starting ISE AD Connector...
Note: ISE Processes are initializing. Use 'show application status ise'

CLI to verify all processes are in running state.
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ise/admin(config-GigabitEthernet)#

Reset a lost, forgotten, or compromised password using a DVD
Before you begin

Understand these connection-related conditions that can cause problems when you use the Cisco ISE software
DVD to start device.

• If your terminal server associated with the serial console connection to the Cisco ISE appliance is set to
exec, only one connection method is available. After you set it to no exec, you can use both a keyboard
and video monitor connection and a serial console connection.

• If you have a keyboard and video monitor connection to the Cisco ISE appliance, you can use a remote
keyboard and video monitor connection or a VMware vSphere client console connection.

• Ensure you have a serial console connection to the Cisco ISE appliance.

Procedure

Step 1 Ensure that the Cisco ISE device is powered up.
Step 2 Insert the Cisco ISE software DVD.

Step 3 Use the arrow keys to select System Utilities (Serial Console) if you use a local serial console port connection or select
System Utilities (Keyboard/Monitor) if you use a keyboard and video monitor connection to the appliance, and press
Enter.

The system displays the ISO uses menu as shown here.
Available System Utilities:
[1] Recover Administrator Password
[2] Virtual Machine Resource Check
[3] Perform System Erase
[q] Quit and reload

Enter option [1 - 3] q to Quit:

Step 4 Enter 1 to recover the administrator password.

The console displays:

Admin Password Recovery
This utility will reset the password for the specified ADE-OS administrator.
At most the first five administrators will be listed. To cancel without
saving changes, enter [q] to Quit and return to the utilities menu.

[1]:admin
[2]:admin2
[3]:admin3
[4]:admin4

Enter choice between [1 - 4] or q to Quit: 2
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Password:
Verify password:

Save change and reboot? [Y/N]:

Step 5 Enter the number for the admin user whose password you want to reset.
Step 6 Enter the new password and verify it.
Step 7 Enter Y to save the changes.

Reset a disabled password due to administrator lockout
If you enter an incorrect password five times, your account becomes disabled.

Use these instructions to reset the administrator user interface password with the application reset-passwd
ise command in the Cisco ISE CLI. Resetting the administrator password activates new credentials immediately
and allows you to log in without rebooting the system. This process does not affect the administrator's CLI
password.

Cisco ISE adds a log entry in the Administrator Logins window. To view this window, click the Menu icon
( ) and chooseOperations >Reports >Reports >Audit >Administrator Logins. Reset your administrator
ID password to regain access to your credentials.

Procedure

Step 1 Access the direct-console CLI and enter:

application reset-passwd ise administrator_ID

Step 2 Specify and confirm a new password that is different from the passwords that were usedmost recently for this administrator
ID.

Enter new password:
Confirm new password:

Password reset successfully

Change the IP address of a Cisco ISE appliance
Before you begin

• Deregister your Cisco ISE node from the distributed deployment. Then, convert it to a standalone node
before you change the IP address

• Do not use the no ip address command when changing the Cisco ISE device's IP address.
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Procedure

Step 1 Log in to the Cisco ISE CLI.
Step 2 Enter these commands:

a) configure terminal
b) interface GigabitEthernet 0
c) ip address new_ip_address new_subnet_mask

When prompted for the IP address change, enter Y. A similar screen appears.

ise-13-infra-2/admin(config-GigabitEthernet)# ip address a.b.c.d 255.255.255.0

% Changing the IP address might cause ISE services to restart
Continue with IP address change? Y/N [N]: y
Stopping ISE Monitoring & Troubleshooting Log Collector...
Stopping ISE Monitoring & Troubleshooting Log Processor...
Stopping ISE Identity Mapping Service...
Stopping ISE pxGrid processes...
Stopping ISE Application Server...
Stopping ISE Certificate Authority Service...
Stopping ISE Profiler Database...
Stopping ISE Monitoring & Troubleshooting Session Database...
Stopping ISE AD Connector...
Stopping ISE Database processes...
Starting ISE Monitoring & Troubleshooting Session Database...
Starting ISE Profiler Database...
Starting ISE pxGrid processes...
Starting ISE Application Server...
Starting ISE Certificate Authority Service...
Starting ISE Monitoring & Troubleshooting Log Processor...
Starting ISE Monitoring & Troubleshooting Log Collector...
Starting ISE Identity Mapping Service...
Starting ISE AD Connector...
Note: ISE Processes are initializing. Use 'show application status ise'
CLI to verify all processes are in running state.

When the process is complete, restart the system when prompted.

Step 3 To restart the system, enter Y.

View installation and upgrade history
You can use a CLI command in Cisco ISE to view the details of installing, upgrading, and uninstalling releases
and patches. To view these details, enter the show version history command.

• Date: Indicates date and time at which the installation or uninstallation was performed.

• Application: The Cisco ISE application used for installation or upgrade.

• Version: Version that was installed or removed.

• Action: Installation, uninstallation, patch installation, or patch uninstallation.
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• Bundle Filename: Specifies the name of the bundle that was installed or removed.

• Repository: The repository you used to install the Cisco ISE application bundle. This does not apply if
you uninstall the application..

Procedure

Step 1 Log in to the Cisco ISE CLI.
Step 2 Enter this command: show version history.

This output appears:

ise/admin# show version history
---------------------------------------------
Install Date: Fri Nov 30 21:48:58 UTC 2022
Application: ise
Version: 3.x.0.xxx
Install type: Application Install
Bundle filename: ise.tar.gz
Repository: SystemDefaultPkgRepos

ise/admin#

Perform a system erase
You can securely erase all information from your Cisco ISE appliance or VM by performing a system erase.
This method helps you comply with NIST Special Publication 800-88 data destruction standards.

This method ensures Cisco ISE compliance with NIST Special Publication 800-88 data destruction standards.

Before you begin

Understand these connection-related conditions that may cause problems when you use the Cisco ISE software
DVD to start a Cisco ISE appliance:

• If your terminal server is associated with the serial console connection to the Cisco ISE appliance and
is set to exec, change the setting to no exec. This change allows you to use both a KVM connection and
a serial console connection.

• Set up a keyboard and video monitor (KVM) connection to the Cisco ISE appliance. Use either a remote
KVM connection or a VMware vSphere client console connection.

• Set up a serial console connection to the Cisco ISE appliance.

Procedure

Step 1 Ensure that the Cisco ISE device is powered up.
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Step 2 Insert the Cisco ISE software DVD.
Step 3 Use the arrow keys to select System Utilities (Serial Console), and press Enter.

The system displays the ISO utilities menu as shown here:

Available System Utilities:

[1] Recover administrator password
[2] Virtual Machine Resource Check
[3] System Erase
[q] Quit and reload

Enter option [1 - 3] q to Quit:

Step 4 Enter 3 to perform a system erase.

The console displays:
********** W A R N I N G **********
THIS UTILITY WILL PERFORM A SYSTEM ERASE ON THE DISK DEVICE(S). THIS PROCESS CAN TAKE UP TO 5 HOURS
TO COMPLETE. THE RESULT WILL BE COMPLETE
DATA LOSS OF THE HARD DISK. THE SYSTEM WILL NO LONGER BOOT AND WILL REQUIRE A RE-IMAGE FROM INSTALL
MEDIA TO RESTORE TO FACTORY DEFAULT STATE.

ARE YOU SURE YOU WANT TO CONTINUE? [Y/N] Y

Step 5 Enter Y.

The console prompts with another warning:
THIS IS YOUR LAST CHANGE TO CANCEL. PROCEED WITH SYSTEM ERASE? [Y/N] Y

Step 6 Enter Y to perform a system erase.

The console displays:
Deleting system disk, please wait…
Writing random data to all sectors of disk device (/dev/sda)…
Writing zeros to all sectors of disk device (/dev/sda)…
Completed! System is now erased.
Press <Enter> to reboot.

To reuse the appliance after performing a system erase, boot the system using the Cisco ISE DVD and choose the install
option from the boot menu.

Cisco Identity Services Engine Installation Guide, Release 3.4
114

Common System Maintenance Tasks
Perform a system erase



C H A P T E R 7
Cisco ISE Ports Reference

• Cisco ISE all persona nodes ports, on page 115
• Cisco ISE infrastructure requirements, on page 116
• Operating system ports, on page 117
• Cisco ISE administration node ports, on page 120
• Cisco ISE monitoring node ports, on page 122
• Cisco ISE policy service node ports, on page 124
• Cisco pxGrid service ports, on page 128
• OCSP and CRL service ports, on page 128
• Cisco ISE processes, on page 129
• Required internet URLs, on page 129

Cisco ISE all persona nodes ports
This table shows the ports used by all Cisco ISE nodes.

Table 18: Ports used by all Cisco ISE nodes

Ports on other Ethernet interfaces
(Gigabit Ethernet 1–5 or Bond 1 and
Bond 2)

Ports on Gigabit Ethernet 0 or on Bond 0Cisco ISE service

Not applicable• HTTPS (SOAP) protocol: TCP port
443

• Data synchronization and replication
(JGroups) protocol uses TCP port
12001 (Global)

• Cisco ISE messaging service - SSL:
TCP port 8671

• Cisco ISE internal communication:
TCP port 15672

• Profiler endpoint ownership
synchronization and replication: TCP
port 6379

Replication and
synchronization
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The TCP keepalive interval on Cisco ISE is 60 minutes. If a firewall is deployed between Cisco ISE nodes,
configure firewall TCP timeout values accordingly.

Cisco ISE infrastructure requirements
This section describes the infrastructure requirements and design considerations for deploying Cisco ISE. It
outlines management access restrictions, network interface limitations, port and firewall requirements, and
supported deployment models to help ensure proper connectivity, policy enforcement, and Cisco ISE operation.

Management interface requirements

Management access to Cisco ISE is restricted to the management interface.

• Management access is allowed only through Gigabit Ethernet 0.

• Administrative access includes the web-based GUI, CLI, and APIs.

• Other network interfaces are not used for management access.

Network interface and VLAN requirements

• Cisco ISE interfaces do not support VLAN tagging.

• Switch ports connected to Cisco ISE nodes must be configured as access ports.

• VLAN trunking must be disabled.

• Each network interface card (NIC) can be assigned a unique IP address.

Ports and firewall requirements

Cisco ISE uses a restricted port model and opens only the ports required by enabled services.

• Ports not explicitly required by active services are denied by default.

• The ephemeral port range used by Cisco ISE is 10000–65500.

• Firewalls must allow required service ports and the ephemeral port range.

RADIUS traffic handling

• RADIUS authentication and accounting traffic is accepted on all available NICs.

• RADIUS traffic is not limited to the management interface.

Cloud and virtual deployment requirements

• VMware on Cloud deployments are supported.

• Connectivity must be provided using a site-to-site VPN.

• Network address translation (NAT) and port filtering are not supported between Cisco ISE nodes and
network access devices.
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Operating system ports
This table lists the TCP ports that NMAP uses for OS scanning. NMAP also uses ICMP and UDP port 51824.

Table 19: Operating system ports

191713976431

323026252423222120

807970534943423733

999089888584838281

135125119113111110109106100

211199179163161146144143139

301280264259256255254222212

417416407406389366340311306

481465464458445444443427425

543541524515514513512500497

616593587563555554548545544

668667666648646636631625617

722720714711705700691687683

808801800787783777765749726

903902901900898888880873843

999995993992990987981912911

102210211011101010091007100210011000

103110301029102810271026102510241023

1040-110010391038103710361035103410331032

111211111110110811071106110511041102

112611241123112211211119111711141113

114811471145114111381137113211311130

116911661165116411631154115211511149

119911981192118711861185118311751174

124412361234123312181217121612131201
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130012961287127712721271125912481247

141713521334132813221311131013091301

150315011500149414611455144314341433

164116001594158315801556153315241521

172017191718171717001688168716661658

181218051801178317821761175517231721

193519141900187518641863186218401839

2021202020131998-201019841974197219711947

20652045-20492040-2043203820352034203320302022

21262121211921112105-21072103210020992068

219621912190217921702161216021442135

2381-238323662323230122882260225122222200

255725252522250024922401239923942393

270227012638260826072605260426022601

287528692811280928002725271827172710

300330013000299829682967292029102909

305230313030301730133011300730063005

326832613260322132113168312830773071

332533243323332233063301330032833269

339033893372337133703369336733513333

365935803551354635273517349334763404

380938013800378437663737370336903689

388038783871386938513828382738263814

399539863971394539203918391439053889

42424224412941264125411140454000-40063998

455044494446444544444443434343214279

503050095000-5004499849004899484846624567

510050875080506150605054505150505033

522552225221521452005190512051025101
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543254315414540553575298528052695226

563155665560555555505544551055005440

580258015800573057185679567856665633

587758625859585058255822581558115810

595959525950592559225915591159105900-5907

6106610161006059602560095998-60075987-59895960-5963

654365106502638963466156612961236112

66896669666866676666664665806565-65676547

690168816839679267896788677966996692

707070257019700770047002700170006969

749674437435740272017200710671037100

791178007778777777417676762776257512

800780028001800079997938793779217920

804580428031802280218011801080098008

819481938192818181808100809980938080-8090

838383338300829282918290825482228200

865486528651864986008500844384028400

900290019000899488998888887388008701

908190809071905090409011901090099003

911191109103910291019100909990919090

950295009485941894159290922092079200

987696669618959595949593957595359503

996899449943992999179900989898789877

1001010009100041000310002100011000099999998

106161056610243102151018010082100251002410012

119671111111110107781062910628106261062110617

140001378313782137221345612345122651217412000

157421566015004150031500215000144421444114238

169931699216113160801601816016160121600116000
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193501931519283191011898818101180401798817877

208282022220221200312000520000198421980119780

270002621425735257342480024444235022293921571

309513071830000282012771527356273552735327352

327743277332772327713277032769327683133731038

327833278232781327803277932778327773277632775

355003460134573345723457133899333543278532784

444434444244176425104151140911401933829236869

491574915649155491544915349152480804510044501

491764917549167491654916349161491604915949158

503895030050006500035000250001500004999949400

528695284852822526735149351103508005063650500

572945673856737556005555555056550555432854045

646236333162078619006153260443600205808057797

65389651296500064680

Cisco ISE administration node ports
This table shows the ports used by Cisco ISE administration nodes.
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Table 20: Ports used by the administration nodes

Ports on other Ethernet Interfaces
(Gigabit Ethernet 1 through 5, or Bond
1 and 2)

Ports on Gigabit Ethernet 0 or Bond 0Cisco ISE service

Not applicable• HTTPS: TCP/443

• SSH Server: TCP/22

• CoA

• External RESTful Services (ERS)
REST API: TCP/9060

he ERS and OpenAPI services are
HTTPS-only REST APIs and operate
over port 443. Currently, ERS APIs
also operate over port 9060. This port
might not be supported for ERS APIs
in later Cisco ISE releases. We
recommend that you only use port 443
for ERS APIs. The default conn-limit
value for port 9060 is 30. If
consecutive ERS API calls are
returning a HTTP 502 error, we
recommend that you increase the
conn-limit value of port 9060 to 60
using the command conn-limit cl1 60
port 9060.

• External RESTful Services (ERS)
REST API Certificate-based
authentication for DNAC integration
mode: TCP/9062

• To manage guest accounts from
Admin GUI: TCP/9002

• Port 443 supports Admin web
applications and is enabled by default.

Access to Cisco ISE via HTTPS and
SSH is restricted to Gigabit Ethernet
0.

• For SAML admin login, Port 8443 of
PSN should be reachable from the
device where the admin is trying to do
the SAML login.

Administration

• SNMP Query: UDP/161

This port is route table dependent.

• ICMP

Monitoring
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Ports on other Ethernet Interfaces
(Gigabit Ethernet 1 through 5, or Bond
1 and 2)

Ports on Gigabit Ethernet 0 or Bond 0Cisco ISE service

• Syslog: UDP/20514, TCP/1468

• Secure Syslog: TCP/6514

Default ports are configurable for external logging.

• SNMP Traps: UDP/162

Logging (Outbound)

• Admin user interface and endpoint authentications:

• LDAP: TCP/389, 3268, UDP/389

• SMB: TCP/445

• KDC: TCP/88

• KPASS: TCP/464

• WMI : TCP/135

• ODBC:

The ODBC ports are configurable on the third-party database server.

• Microsoft SQL: TCP/1433

• Sybase: TCP/2638

• PostgreSQL: TCP/5432

• Oracle: TCP/1521, TCPS/2484

• NTP: UDP/123 (localhost interfaces only)

• DNS: UDP/53, TCP/53

• For external identity sources and services reachable only through an interface
other than Gigabit Ethernet 0, configure static routes accordingly.

• Cisco ISE sends an ICMP ping to the configured DNS server when diagnosing
connectivity for an Active Directory connection.

External identity sources
and resources (Outbound)

Guest account and user password expiration email notification: SMTP: TCP/25Email

• Connection to Cisco cloud over TCP/443

• Connection to SSM on-premises server over TCP/443 and ICMP

Smart licensing

Cisco ISE monitoring node ports
Use this table to find the ports used by Cisco ISE nodes with the monitoring persona.
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Table 21: Ports used by monitoring nodes

Ports on other Ethernet interfaces (Gigabit
Ethernet 1 to 5, or Bond 1 and Bond 2)

Ports on Gigabit Ethernet 0 or Bond 0Cisco ISE service

Not applicable• HTTPS uses TCP port 443

• SSH Server uses TCP port 22

Administration

• Simple Network Management Protocol (SNMP): SNMP uses UDP port 161. This
port is route-table-dependent.

• ICMP

Monitoring

• Syslog uses UDP port 20514 and TCP port 1468

• Secure Syslog uses TCP port 6514

Default ports are configurable for external logging.

• SMTP uses TCP port 25 for email of alarms

• SNMP traps use UDP port 162

Logging

• Admin user interface and endpoint authentications:

• LDAP uses TCP ports 389 and 3268, and UDP port 389

• SMB uses TCP port 445

• KDC uses TCP port 88 and UDP port 88

• KPASS uses TCP port 464

• WMI uses TCP port 135

• ODBC:

The ODBC ports are configurable on the third-party database server.

• Microsoft SQL uses TCP port 1433

• Sybase uses TCP port 2638

• PostgreSQL uses TCP port 5432

• Oracle uses TCP ports 1521, 15723, and 16820

• NTP uses UDP port 123 (localhost interfaces only)

• DNS uses UDP port 53 and TCP port 53

For external identity sources and services reachable only through an interface other than
Gigabit Ethernet 0, configure static routes accordingly.

External identity sources and resources
(Outbound)
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Ports on other Ethernet interfaces (Gigabit
Ethernet 1 to 5, or Bond 1 and Bond 2)

Ports on Gigabit Ethernet 0 or Bond 0Cisco ISE service

These ports are required in all types of deployments regardless of being on-premises or
in the cloud.

• MnT node RESTAPIs: TCP 9443. This allows inboundAPI requests for monitoring
and troubleshooting.

• Policy Administration Node (PAN) to MnT: TCP 1521. This enables
communication from the PAN to MnT nodes.

• OpenAPIs: TCP 443, TCP 9070. These provide access to OpenAPI interfaces for
integration.

• ERSAPIs: TCP 443, TCP 9060. These ports facilitate inboundAPI requests through
ERS interfaces.

Ports used for inbound communication

TCP ports 9993, 2000Bulk download for pxGrid

Cisco ISE policy service node ports
Cisco ISE supports HTTP Strict Transport Security (HSTS) to enhance communication security.When enabled,
Cisco ISE includes an HSTS header in its HTTPS responses, instructing browsers to interact with the server
exclusively over HTTPS. If a user attempts to access Cisco ISE via HTTP, the browser automatically upgrades
the connection to HTTPS before transmitting any data. This process prevents unencrypted communication
and eliminates the need for server-side redirects.

This table provides a list of ports used by the PSNs.

Table 22: Ports used by the policy service nodes

Ports on other Ethernet interfaces, or Bond
1, and Bond 2

Ports on Gigabit Ethernet 0 or Bond 0Cisco ISE service

You can manage the device only through
Gigabit Ethernet 0.

• HTTPS: TCP port 443

• SSH server: TCP port 22

• OCSP: TCP port 2560

Administration

Not applicableNode groups or JGroups: TCP port 7800Clustering (Node group)

Not applicableTCP port 9090SCEP

Not applicableUDP port 500IPsec or ISAKMP

TACACS+: TCP port 49Device Administration

Use HTTP and Cisco ISE REST API to transfer TrustSec data to network devices over port
9063.

TrustSec
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Ports on other Ethernet interfaces, or Bond
1, and Bond 2

Ports on Gigabit Ethernet 0 or Bond 0Cisco ISE service

• PSN (SXP node) to NADs: TCP port 64999

• PSN to SXP (internal communication on the same Cisco ISE): TCP port 9644

SXP

TCP port 443TC-NAC

Simple Network Management Protocol (SNMP): UDP port 161. This port is route table
dependent.

Monitoring

• Syslog: UDP port 20514, TCP port 1468

• Secure Syslog: TCP port 6514

You can configure the default ports for external logging.

• SNMP traps: UDP port 162

Logging (Outbound)

• RADIUS authentication: UDP ports 1645, 1812

• RADIUS accounting: UDP ports 1646, 1813

• RADIUS DTLS authentication and accounting: UDP ports 2083.

• RADIUS Change of Authorization (CoA) send: UDP port 1700

• RADIUS Change of Authorization (CoA) listen or relay: UDP ports 1700, 3799

You cannot configure UDP port 3799.

Session
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Ports on other Ethernet interfaces, or Bond
1, and Bond 2

Ports on Gigabit Ethernet 0 or Bond 0Cisco ISE service

• Admin user interface and endpoint authentications:

• LDAP: TCP ports 389, 3268

• SMB: TCP port 445

• KDC: TCP port 88

• KPASS: TCP port 464

• WMI : TCP port 135

• ODBC: The ODBC ports are configurable on the third-party database server.

• Microsoft SQL: TCP port 1433

• Sybase: TCP port 2638

• PostgreSQL: TCP port 5432

• Oracle: TCP port 1521

• NTP: UDP port 123 (localhost interfaces only)

• DNS: UDP port 53, TCP port 53

If an external identity source or service is accessible only through an interface other than
Gigabit Ethernet 0, configure static routes for that interface.

External identity sources and resources
(Outbound)

• TS agent: TCP port 9094

• AD agent: TCP port 9095

• Syslog: UDP port 40514, TCP port 11468

Passive ID (Inbound)

HTTPS (Interface must be enabled for service in Cisco ISE):

• Blocked list portal: TCP port 8000-8999 (default port is TCP port 8444)

• Guest portal and client provisioning: TCP port 8000-8999 (default port is TCP port
8443)

• Certificate provisioning portal: TCP port 8000-8999 (default port is TCP port 8443)

• My devices portal: TCP port 8000-8999 (default port is TCP port 8443)

• Sponsor portal: TCP portal 8000-8999 (default port is TCP portal 8445)

• SMTP guest notifications from guest and sponsor portals: TCP portal 25

Web portal services:

• Guest and web authentication

• Guest sponsor portal

• My devices portal

• Client provisioning

• Certificate provisioning

• Blocked list portal
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Ports on other Ethernet interfaces, or Bond
1, and Bond 2

Ports on Gigabit Ethernet 0 or Bond 0Cisco ISE service

• Discovery (Client side): TCP port 8905 (HTTPS)

Cisco ISE presents the admin certificate for Posture and client provisioning on TCP
port 8905.

Cisco ISE presents the portal certificate on TCP port 8443 (or the port that you have
configured for portal use).

From Cisco ISE release 3.1, port 8905 is disabled by default on non-PSNs. To enable
this port, check the Enable Port 8905 on non-Policy Service Nodes for Posture
Services check box in the General Settings window (Administration > System >
Settings > Posture > General Settings).

• Discovery (Policy Service Node side): TCP port 8443, 8905 (HTTPS) . This is
configurable in the latest Cisco ISE release with Cisco Secure Client release 4.4 and
later.

• Assessment - Posture negotiation and agent reports: TCP port 8905 (HTTPS)

• Bidirectional posture flow - TCP port 8000-8999 (default port is TCP port 8449)

Posture

• Discovery

• Provisioning

• Assessment or heartbeat

• Provisioning - URL redirection: See web portal services: Guest portal and client
provisioning

• For android devices with EST authentication: TCP port 8084. Port 8084 must be added
to the redirect ACL for android devices.

• Provisioning - Active-X and Java applet install (includes the launch of wizard install):
See web portal services: Guest portal and client provisioning

• Provisioning - Wizard install from Cisco ISE (Windows and Mac OS): TCP port 8443

• Provisioning - Wizard install from Google Play (Android): TCP port 443

• Provisioning - Supplicant provisioning process: TCP port 8905

• SCEP proxy to CA: TCP port 443 (Based on SCEP RA URL configuration)

Bring Your Own Device (BYOD) or
Network Service Protocol (NSP)

• Redirection

• Provisioning

• SCEP

• Provisioning - URL redirection: See web portal services: Guest portal and client
provisioning

• API: Vendor specific

• Agent install and device registration: Vendor specific

Mobile Device Management (MDM)
API integration
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Ports on other Ethernet interfaces, or Bond
1, and Bond 2

Ports on Gigabit Ethernet 0 or Bond 0Cisco ISE service

• NetFlow: UDP port 9996 can be configured

• DHCP: UDP port 67 can be configured

• DHCP SPAN Probe: UDP/68

• HTTP: 8080

• DNS: UDP port 53 (lookup). This port is route table dependent.

• SNMP query: UDP port 161. This port is route table dependent.

• SNMP trap: UDP port 162 can be configured.

Profiling

Cisco pxGrid service ports
From Cisco ISE release 3.1, all pxGrid connections must use version 2.0. Integrations that rely on pxGrid
version 1.0 (XMPP-based) are no longer operational. We recommend upgrading your other systems to Cisco
pxGrid 2.0-compliant versions to avoid potential disruptions to integrations.

This table lists the ports used by Cisco pxGrid service nodes.

Table 23: Ports used by Cisco pxGrid service nodes

Ports on other Ethernet interfaces (Gigabit
Ethernet 1 through 5, or Bond 1 and Bond
2)

Ports on Gigabit Ethernet 0 or Bond 0Cisco ISE service

TCP port 8910pxGrid subscribers

TCP port 8910Inter-node communication

OCSP and CRL service ports
The ports required for Online Certificate Status Protocol (OCSP) and Certificate Revocation List (CRL)
services depend on the CA server or the service hosting OCSP or CRL. Cisco ISE services and ports
documentation lists the basic ports used by the Cisco ISE administration node, monitoring node, and policy
service node separately.

For OCSP, the default port is TCP 443. The Cisco ISE Admin portal accepts HTTP-based URLs for OCSP
services. Non-default ports can also be used.

For CRL, the default protocols are HTTP, HTTPS, and LDAP. The default ports are 443 (HTTPS) and 389
(LDAP), respectively. The actual port depends on the CRL server.
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Cisco ISE processes
This table lists the Cisco ISE processes and their service impact.

Service impactDescriptionProcess name

The process must be in the running state for all services
to work properly.

Oracle Enterprise Database listenerDatabase listener

The process must be in the running state for all services
to work properly.

Oracle Enterprise Database server, which
stores both configuration and operational data

Database server

Must be in running state for all services to work properlyMain Tomcat server for Cisco ISEApplication server

The process must be in the running state for Cisco ISE
profiling service to work properly.

Redis database for Cisco ISE profiling serviceProfiler database

The process must be in the running state for Cisco ISE to
perform Active Directory authentications.

Active Directory runtimeAD connector

Must be in Running state for all services to work properly.Oracle TimesTen Database for monitoring
and troubleshooting (MnT) service

MnT session database

The process must be in the running state to support MnT
operational data.

Log collector for MnT serviceMnT log collector

Must be in Running state for MnT operational data.Log processor for MnT serviceMnT log processor

The process must be in the running state if Cisco ISE
internal Certificate Authority (CA) is enabled.

Cisco ISE Internal Certificate Authority (CA)
service

Certificate authority
service

Required internet URLs
This table lists the features that use certain URLs. You must configure either your network firewall or a proxy
server so that IP traffic can travel between Cisco ISE and these resources. If you cannot provide access to a
required URL, the related feature may not work as intended.

Configure your network firewall or proxy server to allow IP traffic between Cisco ISE and these resources.
If access to any required URL is not possible, the feature may not function as intended.

Table 24: Required URLs access

URLsFeature

https://www.cisco.com/

https://iseservice.cisco.com

Posture updates

https://ise.cisco.comProfiling feed service

https://smartreceiver.cisco.comSmart licensing

https://connectdna.cisco.com/Telemetry
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URLsFeature

https://dna.cisco.com

https://dnaservices.cisco.com

https://ciscodnacloud.com

Connection from Cisco ISE to Cisco pxGrid Cloud Portal

http://api.use1.prd.kairos.ciscolabs.com for the US East region

http://api.euc1.prd.kairos.ciscolabs.com for EU central region

Network connectivity to these required URLs is through HTTPS,
TCP port 443.

Cisco AI analytics

graph.microsoft.com

login.microsoftonline.com:443

*.login.microsoftonline.com:443

*.login.microsoft.com:443

Microsoft Entra ID

public.ecr.awsWorkload connector

facebook.co

akamaihd.net

akamai.co

fbcdn.net

Social login for self-registered guests

*.duosecurity.com:443Cisco DUO integration for multifactor authentication

The Interactive Help feature requires Cisco ISE to connect to these URLs through the administration portal
browser:

• *.walkme.com

• *.walkmeusercontent.com

Cisco Identity Services Engine Installation Guide, Release 3.4
130

Cisco ISE Ports Reference
Required internet URLs


	Cisco Identity Services Engine Installation Guide, Release 3.4
	Network Deployments in Cisco ISE
	Cisco ISE network architecture
	Cisco ISE deployment terminology
	Node types and personas in distributed deployments
	Administration nodes
	Policy Service nodes
	Monitoring nodes
	pxGrid nodes

	Cisco ISE deployment models
	Small network deployments
	Split deployments

	Medium-sized network deployments
	Large network deployments
	Centralized log management
	Load balancers for centralized networks
	Dispersed network deployments
	Considerations for planning a network with several remote sites

	Cisco ISE deployment sizing guidelines
	Switch and Wireless LAN Controller configuration required to support Cisco ISE functions

	Cisco Secured Network Server Series Appliances and Virtual Machine Requirements
	Cisco ISE hardware and virtual appliance requirements
	Cisco SNS hardware appliances
	Support for Cisco SNS 3800 series appliance

	VMware virtual machine requirements
	Linux KVM requirements
	Microsoft Hyper-V requirements
	Nutanix AHV requirements
	Red Hat OpenShift requirements

	VMware cloud solutions for Cisco ISE
	Virtual machine size recommendations
	Disk space requirements for VMs in a Cisco ISE deployment
	Disk space guidelines for Cisco ISE
	CPU requirements for hypervisors

	Install Cisco ISE
	Install Cisco ISE using Cisco Integrated Management Interface
	Installation metrics for Cisco ISE

	Run the setup program of Cisco ISE
	Verify the Cisco ISE installation process
	Install Cisco ISE from an ISO on OpenStack
	Install Cisco ISE on a Cisco SNS appliance using NFS
	Localized ISE installation

	Additional Installation Information
	Tools used to create a bootable USB device from Installation ISO File
	SNS Appliance Reference
	Create a Bootable USB Device Using Rufus
	Create a Bootable USB Device Using Fedora Media Writer
	Create a Bootable USB Device Using balenaEtcher
	Reimage the Cisco SNS Hardware Appliance

	VMware Virtual Machine
	Virtual Machine Resource and Performance Checks
	Install Cisco ISE on VMware Virtual Machine Using the ISO File
	Prerequisites for Configuring a VMware ESXi Server
	Virtualization Technology Check
	Enable Virtualization Technology on an ESXi Server
	Configure VMware Server Interfaces for the Cisco ISE Profiler Service

	Connect to the VMware Server Using the Serial Console
	Configure a VMware Server
	Increase Virtual Machine Power-On Boot Delay Configuration
	Install Cisco ISE Software on a VMware System
	VMware Tools Installation Verification
	Verify VMWare Tools Installation Using the Summary Tab in the vSphere Client
	Verify VMware Tools Installation Using the CLI
	Support for Upgrading VMware Tools


	Clone a Cisco ISE Virtual Machine
	Clone a Cisco ISE Virtual Machine Using a Template
	Create a Virtual Machine Template
	Deploy a Virtual Machine Template

	Change the IP address and hostname of a cloned virtual machine
	Connect a Cloned Cisco VM to the Network

	Migrate Cisco ISE VM from Evaluation to Production
	Check Virtual Machine Performance On-Demand
	Virtual Machine Resource Check from the Cisco ISE Boot Menu

	Linux KVM
	KVM Virtualization Check
	Install Cisco ISE on KVM

	Microsoft Hyper-V
	Create a Cisco ISE virtual machine on Hyper-V
	Zero Touch Provisioning
	Configure Public Key Authentication
	First Login Password Change
	Automatic Installation in Virtual Machine
	Automatic Installation in Virtual Machine Using the ZTP Configuration Image File
	Automatic Installation in Virtual Machine using VM User Data

	Automatic Installation in Appliance
	Automatic Installation in Appliance Using the ZTP Configuration Image File
	Trigger Automatic Installation using UCS XML APIs

	OVA Automatic Installation
	Automatic OVA Installation Using the ZTP Configuration Image File
	OVA Automatic Installation Using the VM User Data

	Create a ZTP Configuration Image File
	VM User Data


	Installation Verification and Post-Installation Tasks
	Log in to the Cisco ISE web-based interface
	Differences between CLI admin and web-based admin user tasks
	Create a CLI admin
	Create a web-based admin
	Reset a disabled password due to administrator lockout

	Cisco ISE configuration verification
	Verify configuration using a web browser
	Verify configuration using the CLI

	List of post-installation tasks

	Common System Maintenance Tasks
	Bond ethernet interfaces for high availability
	Supported platforms
	Guidelines for bonding ethernet interfaces
	Configure NIC bonding
	Verify NIC bonding configuration
	Remove NIC bonding

	Reset a lost, forgotten, or compromised password using a DVD
	Reset a disabled password due to administrator lockout
	Change the IP address of a Cisco ISE appliance
	View installation and upgrade history
	Perform a system erase

	Cisco ISE Ports Reference
	Cisco ISE all persona nodes ports
	Cisco ISE infrastructure requirements
	Operating system ports
	Cisco ISE administration node ports
	Cisco ISE monitoring node ports
	Cisco ISE policy service node ports
	Cisco pxGrid service ports
	OCSP and CRL service ports
	Cisco ISE processes
	Required internet URLs


